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Before using this software, first read the Installation Guide for details on installing the software.
In addition, be sure to read this Instruction Manual before using the software.
We recommend that you keep this document nearby for future reference.



Congratulations on choosing our product!

Thank you very much for purchasing our product. To obtain the best performance from this device and to
ensure safe and correct operation, please read this Instruction Manual carefully, and then keep it in a safe
place together with your warranty.

Please read before using this product

For designing beautiful embroidery designs

» This system allows you to create a wide variety of embroidery designs and supports a wider range of
sewing attribute settings (thread density, sewing pitch, etc.). However, the final result will depend on your
particular embroidery machine model. We recommend that you make a trial sewing sample with your
sewing data before sewing on the final material.

For safe operation

* Do not save any files on the "PE-DESIGN Software Key" for transferring or storage.
* Do not plug the "PE-DESIGN Software Key" into your embroidery machine.

For a longer service life
*  When storing the "PE-DESIGN Software Key", avoid direct sunlight and high humidity locations. Do not
store the "PE-DESIGN Software Key" close to a heater, iron or other hot objects.
» Do not spill water or other liquids on the "PE-DESIGN Software Key".
* Do not drop or hit the "PE-DESIGN Software Key".

For repairs or adjustments

* In the event that a malfunction occurs or adjustment is required, please consult your nearest service
center.

Notice
» Since this "PE-DESIGN Software Key" device is required to run the software, its replacement value is
the retail price of the software. Please keep in a safe place when not in use.
* Neither this Instruction Manual nor the Installation Guide explains how to use your computer under
Windows®. Please refer to the Windows® manuals.
*  The procedures in this manual are written for use in Windows® 10. If this software is used on an

operating system other than Windows® 10, the procedures and appearance of the windows may differ
slightly.

Trademarks

®

*  Windows™ is a registered trademark of Microsoft Corporation.

«  CoreIDRAW® is a trademark or registered trademark of Corel Corporation and/or its subsidiaries in
Canada, the United States and/or other countries.

«  Adobe® and lllustrator® are either registered trademarks or trademarks of Adobe Systems Incorporated
in the United States and/or other countries.

»  Other product names mentioned in the Instruction Manual and Installation Guide may be trademarks of
registered trademarks of their respective companies and are hereby acknowledged.

Caution

The software included with this product is protected by copyright laws. This software can be used or copied
only in accordance with the copyright laws.

SAVE THESE INSTRUCTIONS
This product is intended for household use.

For additional product information and updates, visit our website at:
http://www.brother.com/ or http://support.brother.com/


http://www.brother.com/
http://support.brother.com/
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Arranging Stitch Patterns

»»> page 21

Changing the Stitching for
Each Shape Pattern

»» page 24

Creating Embroidery
Patterns From a Vector File
»» page 40



Editing an Imported Shape
to Create an Embroidery
Design for an Appliqué

»» page 27
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Auto Punch
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»» page 79
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Combining Text

»» page 64

Cross Stitch

»» page 76

Photo Stitch2

»» page 84



Search by Operation

Visualizing the finished project * asample project that | can follow.

»» page 14, 21, 24, 27, 40, 64, 73, 93
é";‘ ){/5 * to see various sample patterns.
»»> page 44, 64
» to embroider an image file that | have.
»» page 40, 90

Creating patterns * to enter text.
»» page 67

YES D O » to use a photo or illustration.

o } M page 40, 90
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| want ...
Arranging patterns * to move patterns.
O » page 21, 53
@ * to enlarge/reduce patterns.
0 (YES »» page 54

D I U } * to rotate patterns.
! »» page 54

» to enjoy arranging patterns.

| want ... P> page 21, 53

Adding colors * to change color combination.
»»> page 61

¢ to simulate color schemes.

»» page 61




Enhancing with sewing » to change the sew types for patterns.
attributes » page 24, 62

* to make the pattern more expressive.
»» page 62

| want ...
Creating embroidery data » to know what | can do with the data.

»»> page 28, 34

* to preview the finished embroidery.
»» page 35, 36

» to choose the sewing order.
»» page 37

» to embroider with my embroidery machine.
»» page 18, 19

» to save my favorite designs.
»» page 46

» to manage embroidery data | create.
»» page 46, 59
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PE-DESIGN Software Key

In order to use PE-DESIGN PLUS2, the included "PE-DESIGN Software Key" must be plugged into a USB
port of the computer.

The "PE-DESIGN Software Key" prevents unauthorized use of this software. The software cannot be started
if the "PE-DESIGN Software Key" is not plugged in.

* Design is subject to change.

a

» The "PE-DESIGN Software Key" cannot be used as USB media. Do not save embroidery files on the "PE-
DESIGN Software Key" for transferring or storage.

* When the "PE-DESIGN Software Key" is plugged into a USB port of the computer, the [AutoPlay] dialog

box appears. Do not use this dialog box. Click . to close the dialog box, and then start up PE-DESIGN
PLUS2.

PLUSZ (E:)

Choose what to do with remavable drives.

Corfigure this drive for backup
File Histary

Corfigure storage settings
Settings

Open falder to view files

File Explorer

. Take na action

* When the message "Do you want to scan and fix PLUS2 (E:)?" appears, select [Continue without
scanning] and then start up PE-DESIGN PLUS2. The drive name for the PLUS2 differs depending on
computers.

% Microsoft Windows X

&ge Do youwant toscan and fix PLUS2 (E)?

There might be a problem with some files on this device or disc. This
can happen if you remove the device or disc before all files have been
written to it.

= Scan and fix (recommended)
This will prevent future problems when copying files to this
device or disc.

—> Continue without scanning

* Tounplug the "PE-DESIGN Software Key" from the computer, click [Start] - [File Explorer], right-click the
"PE-DESIGN Software Key", and then click [Eject].

» Do not format the "PE-DESIGN Software Key".
» We recommend that you back up this software in order to prepare for unexpected problems.
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Comparison of Types of Data Created

With PE-DESIGN PLUS2

Three types of data are used in PE-DESIGN PLUS2.

Stitch pattern: Most of built-in embroidery data
Text pattern: Data created with the [Text] tools
Shape pattern (Outline pattern): Data created with the [Shapes] tools.

M Stitch pattern

Stitch patterns can be arranged by rotating, flipping over and combining them.

B Text pattern

You can edit text by entering/deleting characters, specify text attributes (such as the font or the
transformation shape) and specify sewing attributes.

B Shape pattern

You can specify region and line sew types as well as sewing attributes, edit paths (by moving/deleting
points, reshaping through handle movements), remove/merge overlapping regions, set hole sewing, and
create offset lines.




Starting Up Applications

Starting up PE-DESIGN
PLUS2

Click ﬂ then [All apps], then [PE-DESIGN
PLUS2], and then click [PE-DESIGN PLUS2].

For Windows® 8.1 users: Click the down arrow in
the bottom-left corner of the [Start] screen to show
the [Apps] view, and then Click [PE-DESIGN
PLUSZ2] under the title [PE-DESIGN PLUS2] in
the screen.

For Windows® 7 or Windows Vista® users: Click

§3. then [All Programs], then [PE-DESIGN
PLUS2], and then click [PE-DESIGN PLUSZ].

About the Startup Wizard

When [PE-DESIGN PLUS2] starts up, the following
wizard appears.
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o Open Instruction Manual
Click this button to open the Instruction
Manual (in PDF format).

e Auto Punch / Cross Stitch / Photo

Stitch

Click this button to start the wizard for

creating an embroidery pattern from an

image.

»» "Creating Embroidery Patterns Using
Images" on page 73 and "Importing
and Editing Image Data" on page 90

9 Set Hoop Size
Click this button to specify the size of the
Design Page (embroidery hoop size).
»»> "Specifying the Design Page
Settings" on page 32

O A O % . 0 %
Click these buttons to import the pattern
shown on the button from the [Import]
pane.

0 Most Recently Used Files
Click the name of a file from the list, and
then click [Open].

e Open Embroidery Design
Click this button to open embroidery data
(-pes).
» "Opening a PE-DESIGN PLUS?2 file"

on page 43

9 Always show Wizard at Startup
Select this check box to start up the
wizard each time PE-DESIGN PLUS2 is
started up.

@ Close this Wizard

Click this button to close the Startup
Wizard without performing an operation.

A

To open the wizard while you are using the [PE-
DESIGN PLUS2], click [==] in the [Quick Access

Toolbar], or click .F:, and then select [Wizard]
from the command menu.




Understanding Windows

PE-DESIGN PLUS2 Window
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1 Application button

Click to display a menu containing commands
for file operations, such as [New], [Save],
[Print] and [Design Settings].

Ribbon

Click a tab at the top to display the
corresponding commands.

Refer to the name below each group when
selecting the desired command. Clicking a

v

command with the mark displays a menu
containing a choice of commands.

Quick Access Toolbar

This contains the most frequently used
commands. Since this toolbar is always
displayed, regardless of the Ribbon tab that is
selected, adding your most often used
commands makes them easily accessible.

»»  "Customizing Quick Access Toolbar" on

page 98
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Option button
Click this button to specify settings for the
Design Page and user thread charts.

Help button §-
Click this button to display the Instruction
Manual and view information about the software.

Sewing Order pane

This pane shows the sewing order. Click the
buttons at the top of the pane to change the
sewing order or thread color.

Import/Color/Sewing Attributes/Text
Attributes panes

This pane combines tabs for importing
embroidery patterns as well as for specifying
thread colors, sewing attributes and text
attributes. Click a tab to display the available
parameters.

Stitch Simulator pane

The Stitch Simulator shows how the pattern will
be sewn by the machine and how the stitching
will appear.



9 Design Page
The actual part of the work area that can be
saved and sewn.

10 Work area

11 Status Bar
This displays the size of the embroidery data,
the number of stitches or a description of the
selected command.

12 View mode buttons
Click a button to change the View mode.

13 Show grid button
Click to switch between displaying and hiding
the grid.

14 Design Property button
Click to display a dialog box containing sewing
information for the embroidery data.

15 Zoom slider
This displays the current magnification ratio.

Click to specify a value for the magnification
ratio.

Drag the slider to change the magnification ratio.

M

» Panes 6, 7 and 8 can be displayed or hidden
from the [Show/Hide] group in the [View] tab. In
addition, these panes can be displayed as
separate dialog boxes (Floating) or attached to
the main window (Docking).

» Position the pointer over a command to display
a ScreenTip, which provides a description of the
command and indicates its shortcut key.
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Customizing the window
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M Quick Access Toolbar/Ribbon

A menu appears when = in the [Quick Access
Toolbar] is clicked.
The menu contains various commands, such as

[Show Above the Ribbon] and [Minimize the
Ribbon], to customize the window.

Example: With [Show Above the Ribbon] selected
and a check mark beside [Minimize the Ribbon]
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M Quick Access Toolbar commands

The first time this application is started up, the
following commands appear in the Quick Access
Toolbar.

|"-i-| .
L Zoom In

Click =, then select or unselect the check boxes

beside the commands to switch between displaying
and hiding them. When the check mark is cleared,
the command is hidden. Alternatively, changes to
the commands listed in the [Quick Access
Toolbar] can be specified in the [Options] dialog
box and all applied at the same time.

»» "Customizing Quick Access Toolbar" on

page 98



B Import/Color/Sewing Attributes/
Text Attributes pane, Sewing
Order pane and Stitch Simulator
pane

Floating

Each tab or the entire pane can be undocked to

become a dialog box that can be moved around the

screen.

¢ Double-click the title bar of the pane, or tab.

* Right-click the pane or tab, and then click
[Floating].

¢ Drag a tab out of the pane.

Docking
Each pane can be docked back to the window.

* Double-click the title bar.
* Right-click the pane, and then click [Docking].

* Drag the title bar to the location where the pane
will be docked.

Hide

When a tab or a pane is no longer needed, it can be

hidden.

» Click = in the upper-right corner of the dialog
box.

* Right-click the tab or dialog box, and then click
[Hide].

¢ To hide the tab, click [View] tab in the Ribbon,
and then click the name in the [View] tab. To
display the tab again, perform the same
operation.

Auto Hide
When a pane is temporarily not needed, it =

Hodu| []

can be moved to the side bar, then -
displayed by clicking it or positioning the  — -]
pointer over it. The pane is automatically = wﬁm
hidden again when it is no longer being aB

used, for example, when you click
anywhere outside of the pane.

* Right-click the tab or the title bar of the pane, and
then click [Auto Hide].

* In the upper-right corner of the pane, click ﬂ- .
To cancel Auto Hide, right-click the title bar, and

then click [Auto Hide], or simply click -2 in the title
bar.
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» The Stitch Simulator pane cannot be temporarily
hidden (Auto Hide).

» These panes can be returned to their default
displays.

»» "Customizing Shortcut keys" on page 99

M Using access keys

When the <Alt> key is pressed, a KeyTip (label
showing the letter of the access key) appears on
each command. On the keyboard, press the key
corresponding to the command that you wish to use.

5
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To stop using the access keys and hide the
KeyTips, press the <Alt> key.

Clipboard




Example of Importing Embroidery Data

Using the Import pane

Embroidery data can be imported by using the
[Import] pane.

Import o x
i_llmpm‘t Kl color {iifil sewing At... ABText Attrib...
o Fram |Deswgn Librarg j
9 Category |Barders & Banners ﬂ
©— 8
3302115 pes 33102116 pes 33102118 pes
33102119 pes  Boutigueh.pes  CardBB pes
E i s Ag v
o _—  lmpot

o From

Select a pattern location.

e Category
Select a pattern category.
The categories in the pattern location

selected in the [From] selector are listed.

©

The patterns in the category selected in
the [Category] selector appear in the list.
Pointing to a pattern and holding down the
left mouse button displays a dotted box in
the Design Page. This allows you to
check the size of the pattern.

Import
Click this button to import the selected
pattern.

M

* The pattern can also be imported by
double-clicking it in the list or by dragging it to
the Design Page.

» Multiple files cannot be selected to be imported
at the same time.

» "From a folder" on page 44
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Using Import commands
1  Click the [Home] tab.

2  Click [Import Patterns] in the [Import] group,
and then click [from Design Library] or [from
File] from the [Import] menu.

Urtitled - PE-DESIGN PLUS2
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— The [Import] pane appears on the right
side of the screen.

A

The [Import] pane can also be displayed by
selecting the [Import Pane] check box in the
[View] tab.
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the [Import] tab to display the [Import] pane.
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Basic Operations

Tutorial 1: Making a Quilt Using an
Embroidery Pattern

This section will describe how to create an embroidery pattern for quilting. We will use the Shapes tools to
draw lines for positioning fabric and for stitching. This data will then be transferred to an embroidery machine
in order to make a quilt.

The sampile file for this tutorial is located at:
Documents (My documents)\PE-DESIGN PLUS2\Tutorial\Tutorial_1

Step 1 Importing image data into PE-DESIGN PLUS2

Step 2 Changing the grid settings

Step 3 Scaling an image

Step 4 Adjusting the density of the background image

Step 5 Drawing straight lines for positioning fabric

Step 6 Drawing straight lines for stitching fabrics with right sides together
Step 7 Transferring embroidery patterns to embroidery machines

Step 8 Quilting with the machine

Step 1 Importing image data into M

PE-DESIGN PLUS2 When this application is installed, the [PE-

1 Click the [Image] tab DESIGN PLUS2] folder is installed in the
' Documents folder.

2 Click [Open] in the [Image] group, and then

click [from File]. 4  Select the file [House_Line.bmp], and then
s unt click [Open], or double-click the file's icon.
*

S Home Image Wiew Dpen an image e *

El""" D‘_R.-l.ﬂa Righit - mn—j + [ oF [0
i@’ 3, Modify image & | Rotatr Left ? 25@ F:h% e ) ;’;ﬁ -
TR —o— @ || {§ cese Funeh Stteh - Stitch 1- aau

|\ ooen imane Edit Stitch Wizard e

] from File.., ‘ s = F P
#i Trom Cliphoard... " ] (50

3  Double-click the [Documents (My . s
documents)\PE-DESIGN PLUS2\Tutorial\ |
Tutorial_1] folder to open it.

— The image appears in the work area.
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Tutorial 1: Making a Quilt Using an Embroidery Pattern

@ Handle
® Red line

M

AR
=

« This image was created by adding lines,
separated by the width of the seam allowance,
to the outside of the shapes in the illustration of
the house.

* To create a similar quilt:

- First, print the design.

- Draw lines (for the seam allowances) about
7 mm from each of the shapes in the design.

- Scan the image, save it to a computer, and
then import it into PE-DESIGN PLUS2 as a
background image.

Step 2 Changing the grid settings

Use the grid settings to draw lines for positioning the
fabric.

A grid of dotted lines or solid lines can be displayed
or hidden, and the spacing for the grid can be
adjusted.

1  Click [View] tab.
2  Specify the grid settings.

@ — [ showsrid  Intervak |25 2 |

©

with Axes

o —| Snap to Grid
| Grid

o Show Grid
Select this check box to display the grid.

— For this example, select this check
box.

15

e with Axes
Select this check box to display the grid as
solid lines.

— For this example, select this check
box.

Interval

Specify the grid spacing.

— For this example, set [Interval] to 3.5
mm.

Snap to Grid

Select this check box to align patterns
with the grid. The snap feature works
whether or not the grid is displayed.

— For this example, select this check
box.

M

The | button can also be used to switch the
grid between being displayed or hidden.

—j— ™ Auka Serol
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Step 3 Scaling an image

1  Drag the handle to adjust the image to the
desired size.
Enlarge the image to the maximum size of
about 95 mm square and position it with the
corners of its outline at intersections of the
grid.




Tutorial 1: Making a Quilt Using an Embroidery Pattern

Step 4 Adjusting the density of
the background image

Click the [Image] tab.

Drag the slider, or click @ or @ in the

[Image] group to change the density of the
template image to "25%".
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M

Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying it
faded at each density (75%, 50% and 25%) to
hiding the image (Off).

Step 5 Drawing straight lines for
positioning fabric

Shapes can be created either by drawing them with
the Shapes tools.

To draw a shape, select a Shapes tool, and then
drag the pointer in the Design Page to draw the
shape.
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@ Shapes tools
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Specify the sew types for the shape on the [Shapes]
tab, and the thread colors on the [Shapes] tab or the
[Color] pane.

The screen changes so that the sew types and
thread colors for the shape can be specified. The
thread colors can also be specified on the [Color]
pane.

@ &)

Ii' wasassn Zigzag Stitch <

(I~ HEEEEEED Fin stiten B
SE\lr

Line color button

Line sew type selector

Region color button

Region sew type selector

Selected thread color and color name
Thread color palette

CICISISICIS)

Draw straight lines as reference for positioning the
fabric.

1  Click the [Home] tab.

2 Click [Shapes] in the [Tools] group, and then
click ' = in the Shapes tools.
g Lt o el o O
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Tutorial 1: Making a Quilt Using an Embroidery Pattern

3 Clickthe [Line sew type] selector, and then
select [Running Stitch].
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e Tiazao Stitch

Input

4  Click the [Color] tab to display the color
palette.

- [m] >
Dotion §

| Coler P x
Ca EJImnDrtwsewlngAt... AB et Aittrib,.

5  Click [BLACK].
Thead Chal: [BROTHER EMBROIDERT =]

900
I EMERDIDERT
BLACK

OSLELIN L F

Tolist mode:

M

To view the thread colors in a list so that the
desired color can more easily be found, click [To
list mode].

»» "Setting the thread color" on page 61

6  Click points o through @

ol

o >
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[10)

7  Double-click end point .

M

The color, sewing attributes and size can also be
changed after the shape is drawn.

Step 6 Drawing straight lines for
stitching fabrics with right
sides together

We will draw lines at the positions where the
machine will sew. The machine will sew the fabric in
the order that the lines are drawn.

A different color must be specified for each line.
1 Repeat 1 through 4 under "Step 5 Drawing

straight lines for positioning fabric" on
page 16.

2  Specify a line color different from what is
already selected.
For this example, select [RED].
Thread Chart [BROTHER EMBROIDERY  _~|

800
i EMBROIDERY
RED

OIS LF
11 T IS



Tutorial 1: Making a Quilt Using an Embroidery Pattern

Click point o and then double-click end point
@ to draw line (1).

=

Line (1)

Repeat the previous steps to draw lines (2),
(3) and (4).
For this example, select [LIME GREEN] for
line (2), [PUMPKIN] for line (3), and [BLUE]
for line (4).

Line (3)~d | L Line (2)

1 o

Line (4)
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Step 7 Transferring embroidery
patterns to embroidery
machines

You can sew a pattern transferred to your
embroidery machine by writing it to media.

For details, refer to the Operation Manual provided
with your embroidery machine.

Designs can be transferred to an embroidery
machine compatible with USB media or connected
to a computer using a USB cable.

a

The "PE-DESIGN Software Key" cannot be used
as USB media. Do not save embroidery files on
the "PE-DESIGN Software Key" for transferring.

1  Plug the USB media into the computer, or
connect the embroidery machine to the

computer.
2  Click the [Home] tab.
3 CcClick [Send] in the [Sew] group, click [Send

to USB Media] or [Send to Your Machine],
and then select the desired drive.

= O kS
Option  § -
8 vy | 'l"L_
o 191 [
Applique || Export Serid
Wizard || FCMFile -
| #pglique] | SanNCut ||| sena Embroidery Desian
M sendto uss Media » F
Lmg imanrt EF SendtoYour Machine  »|] &

— Data transfer begins.

a

If there is already a file with the same name at the
destination, the following dialog box appears.

Select whether to overwrite the existing file, to stop
copying or to copy the file using a different name.

Copy File X
There is alieady a file with the same name in this location

Uniitied PES
= opy and Hepiace:
" Don't copy

" Copy using anather name

Cancel
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4  After the data has been transferred, the
message "Finished outputting data." appears,
indicating that the transfer is finished. Click
[OK].

M

 For details on transferring designs with this
method, refer to the Operation Manual provided
with your embroidery machine.

« If the connected embroidery machine has been
set to Link mode, the command [Send to Your
Machine], mentioned in this procedure, cannot
be selected. To select this command, return the
machine to normal mode.

Step 8 Quilting with the machine

Now, we will use the transferred embroidery
patterns to make a quilt with the house pattern.

1 Cut the fabric for each piece.

2 Hoop the base fabric in the embroidery frame,
and then sew the first color for positioning
fabric.

For this example, sew the [BLACK] line drawn
in "Step 5 Drawing straight lines for positioning
fabric" on page 16.

19

3

5

With right sides together, place fabrics o and
e so that their top edges are aligned with the
horizontal line at the center of the base fabric.

For this example, sew the [RED] line (1)
drawn first in "Step 6 Drawing straight lines for
stitching fabrics with right sides together"” on
page 17.

\

\

\
Line (1)

Fold open the fabrics that were sewn together.
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6 Fold the right side of fabric 9 along the 9  Open the fabrics, and then sew around the
upper-right diagonal line in the base fabric, house pattern.
and then use scissors to cut the fabric. For this example, sew the [BLUE] line (4)

drawn in "Step 6 Drawing straight lines for
stitching fabrics with right sides together" on
page 17.

7 Withits right side down, place fabric € on top
so that it is aligned with the upper-right
diagonal line in the base fabric. Then, start the
machine.

For this example, sew the [LIME GREEN]
line (2) drawn in "Step 6 Drawing straight lines
for stitching fabrics with right sides together"

on page 17.
Lo
| [

0

Line 3) Line )

10 Cut around the house pattern with a 7 mm
seam allowance.

8 Repeat 6 and 7 for fabric @), and then start
the machine.
For this example, sew the [PUMPKIN] line (3)
drawn in "Step 6 Drawing straight lines for
stitching fabrics with right sides together" on
page 17.

20
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Tutorial 2: Arranging Stitch Patterns

This section will describe how to arrange stitch patterns in order to create an embroidery design.
Built-in stitch patterns can be duplicated, flipped over and rotated to create an original embroidery design.

We recommend using a built-in stitch pattern in its original size, or resizing it only slightly.

The sample file for this tutorial is located at:
Documents (My documents)\PE-DESIGN PLUS2\Tutorial\Tutorial_2

M

Stitch patterns contain a collection of information including needle drop points and thread color order. Upon
being resized, the stitching becomes either more dense or light while maintaining the unchanged needle drop
point pattern. These changes may have an influence on the quality of your embroidery project.

Step 1 Setting the design page size
Step 2 Importing and rotating a pattern
Step 3 Duplicating a pattern

Step 4 Flipping a pattern

Step 5 Arranging patterns

2 Fromthe [Hoop Size] selector, select [130 x

Step 1 Setting the design page 180 mm], and then dlick [OK].

.
Design Settings
o ~Page
1 Click (#, then [Design Settings]. Rpe
& 1204180 um -
oY Untitled - PE-DESIGK PLUSD IM
wr 1 fr LED)”
- 1824388 rmbarcchions LCO)
z %300 mm
II new i e o i{ 200 5 200 mm Qi Frame)
e e 200 % 300 mm:
LEnsers. Avog.pes 2405240 rom Qi Frame L]
é open. 2404360 mm )
1
S
IS '
) Bt oK Defaut corcel |
v
(2 orsign Fopeny
| |L_j Dlesigr Settings ..
L
e WVizid.
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Tutorial 2: Arranging Stitch Patterns

Step 2 Importing and rotating a
pattern

1 In the [Import] pane, select [Design Library]
from the [From] selector, then [Floral] from
the [Category] selector. Select
[33100110.pes], and then click [Import].

Impart
il mport | Tl Color #% sewing At.. AH Text Attrib..,

B
5|

n

o X

From

| [DesignLimary

| [Fiaral

= L

| 3T pes TIN00225 pes

Cobzgany

3l

-4

)
JFMZEEpes IR pes DN0MERDes

While holding down the <Shift> key, drag the
red dot at the top of the pattern to the right to
rotate the pattern 90° clockwise o

2

M

Holding down the <Shift> key while dragging the
red dot rotates the pattern in 15° increments.

3 Drag the pattern o to the left side.

22

Step 3 Duplicating a pattern

1 Asin "Importing and rotating a pattern” on
page 22, import pattern [33103503a.pes]
from the [Floral] category in the [Import]

pane.
2 Selectthe pattern, and then click the [Home]
tab.
3 cClick [Duplicate] in the [Clipboard] group to

duplicate the pattern.

— The duplicate appears, overlapping the
original pattern and offset down and to the

right.
’o, Untitled - PE-DESIGN PLUSZ
- Home | Clomee Wiy
\] & A B aag
13 SRy T e snapes % T Inpart
o - - - - Pattams = fove to Certe
| Selest Toals i
I | 1 |
Bl ) %
. ~
¥ o
44. —
- | y
T N
A “alfe !
L | oy
$ o] ro R ¥ 3 ;“
: ! R ,Fe"‘
# =y LA
5 &r‘f
.

M

The [Duplicate] command can also be selected
from the menu that appears after right-clicking the
selected pattern.

4  Move the duplicate pattern below pattern o
and then rotate it 60° counterclockwise e
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Step 4 Flipping a pattern

1 Select the original pattern, then click [Flip] in
the [Edit] group of the [Home] tab, and then
click [Flip Horizontally].

=d - PE-DESIGN PLUS2

= A dF ChefaD = o] e [Em=E] B
E % Maay Creriap E_} Fiip - el Lew
'PE i Groug v B | Flip Vertically 2 :
Imgort Export Send
pameme~ || G Moveto Center | 2 piip Honzantaily. |<m #iie -
Import || Edit Tompmee NGt Sew |

— The selected pattern is flipped horizontally.

¥ ¥
et e
e Nt

The [Flip] command can also be selected from the
menu that appears after right-clicking the selected
pattern.

2 Movethe flipped pattern to the right of pattern
e, and then rotate it 90° clockwise 9
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Step 5 Arranging patterns

1 Arrange the patterns to create a circle as
shown in the figure, using the [Duplicate] and
[Rotate].

2  Select [no77_2.pes] in the [Misc] category of

the [Import] pane, then click [Import], and
then move it below the flower patterns.

Change the sewing order as desired.

»»  For details, refer to "Editing the sewing
order" on page 38.
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Tutorial 3: Changing the Stitching for
Each Shape Pattern

The sew type for areas within closed outlines of text patterns or shapes can be specified.

The sampile file for this tutorial is located at:
Documents (My documents)\PE-DESIGN PLUS2\Tutorial\Tutorial_3

Step 1 Importing an outline shape
Step 2 Applying motif stitches to line
Step 3 Applying programmabile stitches to a shape
Step 4 Applying motif stitches to a shape
Step 1 Importing an outline Step 2 Applying motif stitches to
shape line
1 In the [Import] pane, select [0ut|ine Shapes] Detailed line and region attribute Settings can be
from the [From] selector, then [Misc] from the specified from the [Sewing Attributes] pane. Now,
[Category] selector. Select we will specify settings for line sewing and region
[OL_heart01.pes], and then click [Import]. sewing for the largest heart pattern.
Imood . 1 Click on workspace to deselect the heart

ilmport | Tl cotor #fsewing An. ABTex Attrib...

pattern.

While holding down the <Ctrl> key, click the
line (frame 2) and region (frame 1) of the
largest heart pattern arranged in the [Sewing
Order] pane.

Fram Dutine Shapes B

iz -

2 Click 'k at the top of the [Sewing Order]

pane.
Sewing Order g o, (- . s .
H feirdom 5 [ zmnao - -
e T !

-
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Tutorial 3: Changing the Stitching for Each Shape Pattern

3  Click the [Shapes] ribbon tab.

4 Click the [Region sew type] selector in the
[Sew] group, and then select [Stippling
Stitch].

/7y Untitled - PE-DESIGN PLUSZ | Shapes
Ly

View
O~
O- HEHHI Ao stitn
[ Mat Sewn [Region]

Hame  Image Shapes

J/ EditFaint ~

I \ ill| &% Delet= Poin
Select

Select

®O

Edit Point.

M2 H %% Ele o 7 | WA satin stien
Sewing Draer aox o $iiiEE P stiten

% [ W TR HlHHLH proc. st

Sa | (g Ry \‘ - FEHESE Motif Stitch

0 1 WS suppling stitch
' I
@ Line sew type selector
® Region sew type selector

5  Click the [Line sew type] selector in the
[Sew] group, and then select [Motif Stitch].

Click the [Color] tab. Select the [Line] check
circle, and then click [SKY BLUE] in the list.

T |
L

~ Vi ] e
"~ pen

Theasd Chart

BROTHEREVBROCERY =

When the color palette is displayed in list mode,
the names of the thread colors are shown. To
switch to list mode, click [To list mode] in the
[Color] pane.

Palette mode List mode
Thrwad Chast |EADTHER EMBROCERY - Thwad Chat | EROTHER ENBROIDERY -
D;F‘]IEFW &!ENUIEW
XY BLUE SEYVELLE
mEE  mE = o e
] |3 | EWERNDERT | 5ET AL
DEEEEEEE » ‘B
EEEEDEN R Rumnen T
LB R RN N B B »
I O &= [ @
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7 Click the [Sewing Attributes] tab and then

olick |
If the [Sewing Attributes] pane is not
displayed, click the [View] tab, then

[Attributes], then [Sewing Attributes].
Select the desired motif stitch pattern from the

[Browse] dialog box, and then click [OK].
Specify the motif size.

For this example, select [mot021] and 3.0 mm
for the motif size.

Sewing Sttributes o x Browse
£ limgor chlnrlh’-s«mmn..!" o -
PLing saw _%,
Mokt
‘% motg21 motn2z otz moto2e
=] o
VEaglon sew oo
Aunpdch |19 =lnn Py J
Spacing 20 =0

8  Specify the region sew settings.

For this example, select 1.8 mm for the run
pitch and 2.0 mm for the spacing.

[

“ 4 bpan H Cowy BRsewmg &, RBTem s

WLine gow

Host
= a 30 2] e

7 Bogeon sow
Pen piich

B =

= B =
Spacing B0 o

|

Step 3 Applying programmable
stitches to a shape

1 Select the second-largest heart pattern
(frames 3 and 4) in the [Sewing Order] pane.

o WS T . S W W
LN W = |
B | 15




Tutorial 3: Changing the Stitching for Each Shape Pattern

2 Seta color and sew type for each shape as
follows.

Step 4 Applying motif stitches to

a shape
Line sew
1 Select the smallest heart pattern (frames 5

* Line sew type : Motif Stitch and 6) in the [Sewing Order] pane.

* Line color : CORN FLOWER BLUE [ T - ————
Eimb iy
Region sew ST )| 5 4
CF
* Region sew type : Prog. Fill Stitch v d
*.;9 Untitled - PE-DESIGN DLHSZ Shapes v‘l 4 i
H:n: Image View Shapes - (\\9 3
k' "_::‘:"::‘_-’ '| M- | SRR Matn Stitcn = '.:QI.‘ 7
sed]| T | B e [ e v
Select Edit Point SEW Edit ‘— (1 y
3 Clickthe [Sewing Attributes] tab, and then
specify the following settings. 2  Click the [Shapes] tab.
Line sew Line sew

* Motif pattern : mot022 % + Line sew type : Motif Stitch

* Motif size : 3.6 mm + Line color : PURPLE
Region sew Region sew
* Under sewing : ON * Region sew type : Motif Stitch

» Density : 4.5 line/mm

© ' Untitled - PE-DESIGN PLUSZ | Shapes

) |
S Home  image  View | Shapes

» Direction : Manual, 135 degrees

. __R.‘ ’::_:"t:'.a:_:_‘ M- | BEPERE Matir Stizch
* Pull compensation : 0.3 mm — | e = =3
4 Click under the [Programmabile fill],
select the desired pattern in the [Browse] 3 Click the [Sewing Attributes] tab, and then
dialog box, and then click [OK]. specify the following settings.
For this example, select [pat013]. Line sew
+ Fill stitch pattern : pat013 Q) * Motif pattern : mot024 /

* Motif size : 3.0 mm
« Pattern size : 7.5 mm

Sea A o o Region sew
Edmport EL color &R sewing &4, ABTest atinie. = .
\‘ - + Motif pattern : mot025 oo

VE—[#; T ' % < *  Motif size : 7.5 mm
e MEL) ]

* Mana

& = Fom
Ak

Full [ o
VErmmnmmele il
BV
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Tutorial 4: Editing an Imported Shape to Create an Embroidery Design for an

Appliqué

Tutorial 4: Editing an Imported Shape to
Create an Embroidery Design for an
Appliqué

This section will describe how to edit imported shapes and use the Applique Wizard.

The Applique Wizard provides instructions for easily creating appliqués. For this example, we will create an
appliqué that has holes (empty regions).

The sampile file for this tutorial is located at:
Documents (My documents)\PE-DESIGN PLUS2\Tutorial\Tutorial_4

Step 1 Importing patterns

Step 2 Editing points and modifying shapes

Step 3 Using the mirror copy tool

Step 4 Specifying hole sewing

Step 5 Creating appliqués

Step 1 Importing patterns Step 2 Editing points and
Shapes can be created either by drawing them with mOdIfylng Shapes
the Shapes tools or by importing sample shape Now, we will edit a point in the leaf.

patterns.

1  Click on workspace to deselect the flower.

1 Toimport a shape, select [Tutorial] from the Click on the leaf to select it. Left click and drag
[From] selector of the [Import] pane, then the handle to adjust the leaf.
[Tutorial_04] from the [Category] selector.
Select the shape, and then click [Import].

P — S shape of the pointer changes to <%, and then
e R e drag the leaf to the desired position.

Place the pointer over the leaf so that the

1

27
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Appliqué

2  Edita point.
(A) Click the [Home] tab.
(B) Click [Select] in the [Select] group, and

then click ’7;

(A)—
| A &
(B)— [ i Te;xt Sna'pes
| Seectonts | Clipboard | T
|| — =
|: Saiect AN i‘|| u Elt' ;—I

(C) Click the shape for the leaf.
— The points in the shape appear.

(D) Select the point, and then drag the point to
the desired location.

Step 3 Using the mirror copy tool

1  Click the [Home] tab.

2 Click [Select] in the [Select] group, then click
’E and then select the leaf.
3  Click [Arrange Copy] in the [Clipboard]
group, and then click [Vertical Mirror Copy],
_ Untitled - PE-DESIGN PLUSZ | Shapss
‘{w) Home Image View Shapes
,\(, cut B oupicste
-a Capy ‘%Nmng: Copy 1 ATAW (g\;
s [y Pazte | Arrange Copy Tools '1p
| Select | 4| vertical Mirror Copy _Ta
Dé_ E_(g—). % | Horizontal Mirror Copy
Sﬂﬂmﬂfﬁﬂ' $ Four-\Way Mirror Copy C
(]| % B [ Opton
Chm | [ v || Optimize Sewing Order
4 Move the pointer, and then click when the

patterns are arranged as desired.
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M

+ Arrange copy type

-.ald Vertical Mirror Copy

PP

~2 Horizontal Mirror Copy

) ?
.,.")‘_

PP
OO

» Optimize sewing order
Before using an [Arrange Copy] tool, optimizing
the sewing order adjusts the sewing order of the
patterns created with the [Arrange Copy] tool in
order to reduce the number of thread color
changes.

Four-Way Mirror Copy

Untitle

2y
i Home Imaqe View

| g% Cut B Duplicate

= S r———— A ’E' AR E- l

Select M
I P ’manmIoob &

| Setect s | Vertical Mirrar Capy Toals

"‘1@ E G},Q = | Horzontal Miror Copy
=§2 Fa

waytinorcopy [, [

|| antic

| v opumzesewlng Dides

[Optimize Sewing Order]

[Optimize Sewing Order]

not selected selected
Sewing Order ax Sewing Order ax
L [ L [
o |l W o |l W
1 1
v v
2 2
> v
] ]
v v
1 1
QP <

The sewing order is the Patterns will be sewn so

order in which patterns are that those with the same

created. thread colors will be
connected.
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Appliqué

Step 4 Specifying hole sewing

Now, we will apply a setting so that the overlapping
areas are not sewn twice.

1  While holding down the <Ctrl> key, click the
circle, then the flower.

2 Click the [Home] tab, then click [Modify
Overlap] in the [Edit] group, and then click
[Set hole sewing].

) o

JéEIQEI& |-. .

E".n... = W —

Be G % . .

— When hole sewing is specified, the pattern
displayed in the [Sewing Order] pane
changes.

Sewing Order a X Sewing Order o x
5 o | |CF| 5 o | |CF|
oe | G | oe | G |
1 ° » 1 °
AR AR

a

Hole sewing cannot be applied if one of the
patterns is not completely enclosed within the
other pattern.

»» "Hole sewing" on page 56.
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Step 5 Creating appliqués

1 Select the outer pattern, and then click
[Applique Wizard] in the [Home] tab to start
the [Applique Wizard] dialog box.

y  Unikied - PE-DESIGNPLUS? | Shapm

=

are | inoge
o4 out D upikate
Rycors S ammaecom |

B Dt

1l Wl

Be sure to select the outer pattern before starting
the [Applique Wizard].

2 Specify settings in the [Applique Wizard]
dialog box in the following order o - @
o 6 o © 5]
| | | | |

R e R —
R IRl VR
" s o I A
5 Hom
m
VKI*_H'MM G| Demk Careal |
6]

o Applique Material
Specify cutting lines for the appliqué.
The outline of the appliqué can be sewn
as running stitches to be sewn onto the
appliqué fabric as a guide for cutting it out.

— For this example, select [Yes].

Applique Position

The guideline for attaching the appliqué
piece is set to be sewn automatically.
Tack down

Specify basting of the appliqué.

The appliqué piece can be basted onto
the base fabric.

— For this example, select [Yes].
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Appliqué

e Covering Stitch
Specify the stitching for securing the
appliqué. Select the sew type and other
attributes ([Width] and [Density]) for
finishing the appliqué.
— For this example, set [Width] to "3.0
mm" and [Density] to "5.0 line/mm".

Output Pattern

Select whether covering stitches will be
added around the entire pattern ([Add])
or covering stitches will be sewn for shape
lines ([Replace]).

— For this example, select [Replace].

Add Replace

»» "About the Output Pattern settings"
on page 30.

@ Create an applique with hole sewing
Select this check box when creating an
appliqué with holes (empty regions).

— For this example, select this check
box.

M

* The [Create an applique with hole
sewing] check box appears when only
the outer pattern with hole sewing
applied or only a text pattern (with fonts
other than built-in fonts 025 and 029, or a
Small Text font) is selected, or when
[Replace] is selected under [Output
Pattern].

* Multiple text patterns can be selected if
certain conditions are met.

» The shape of the appliqué material
appears as shown below, depending on
whether the [Create an applique with
hole sewing] check box is selected or
not.

@
O

When the [Create an
applique with hole
sewing] check box is
cleared

When the [Create an
applique with hole
sewing] check box is
selected

30

M

To return all parameters to their default settings,
click [Default].

3 Click [OK] to exit the Applique Wizard dialog

box.

H About the Output Pattern settings

Add

» Covering stitches will be created around the
original pattern.

* Under [Distance from original Pattern], specify
the distance of the covering stitches from the
original pattern.

(7 A

- J

¢ This can be used to combine various patterns.

Helloﬂ {Hello7)

D 6, 9]
C} a ) —l‘--g\ _?:\'J
! N

The [Add] setting is not available if the stitch
pattern does not exist, for example, when both the
line and region sew types are set to [Not Sewn].
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Appliqué

Replace

» Covering stitches will be sewn for outlines in the
original pattern.

* The original pattern will be deleted.

¢ Shape and text patterns can be used as the

original pattern. However, the following patterns

cannot be used.

- Open lines

- Closed lines that are intersecting

- Text created with built-in fonts 025 and 029, or
a Small Text font

- Original patterns containing both a shape
pattern and a text pattern

[

When multiple patterns are selected, covering
stitches will be created as shown below.

« If the patterns do not overlap
Covering stitches will be created for each
pattern.

[Add]

[Replace]

« If the patterns overlap

With the [Add] setting, covering stitches will be
created for an outline around all patterns.

[Add] [Replace]
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Specifying the Design Page Settings

Specifying the Design Page Settings
The color and size of the Design Page can be changed. You can select a Design Page size according to the

size of hoop that you will be using with your embroidery machine. You can also specify a custom size for the
Design Page for embroidery patterns that will be split and embroidered in multiple sections.

1

2

Click (%, then [Design Settings].

Untitied - PE-DESIGM PLUIS2

Most Recently Used Files

LSRR D0 S

1
o [‘ M
—

—
&
A it

L
(25, Desian Froperty

|'l_‘ Design Settings..

Wizaid..,

Specify the settings for the Design Page, and
then click [OK].

00 ©

Design Settings

~Page Si
L— Hoop Size:

1002100 o e
T Rotate 90 Degrees
Edit Liser Haop,

- Dptinize hoop changs

Optinize the number of tnes
' to change the hoop's pasition,

R —
Page: [—
IBechruund | -

x| Defait | e
1

|
© 0 6] 5]

o Hoop Size
Select the desired hoop size from the
selector.

e Rotate 90 Degrees
Select this check box to arrange the
pattern in a Design Page rotated 90°.

9 Edit User Hoop
Click this button to display the [User
Hoop Settings] dialog box, where a user
hoop size can be added. The added user

hoop size appears at the bottom of the list.

»» "Specifying a user hoop size" on
page 33

32

a

* The Design Page sizes 100 x 172 mm, 130 x

e Optimize hoop change
This setting can be selected if a multi-
position hoop (100 x 172 mm or 130 x 300
mm) has been selected as the Design
Page size.
Select the check box to optimize the
sewing order/order of hoop position
changes so that the number of times that
the hoop position is changed is reduced to
the minimum.
This reduces the risk of misalignment in
the embroidery pattern or uneven
stitching from changing the hoop position
too often.

9 Page
Select the desired color for the Design
Page.

©

Background
Select the desired color for the work area.

0 Default
To return to the default settings, click this
button.

300 mm indicated by the "*", are used to
embroider multi-position designs using a special
embroidery hoop attached to the embroidery
machine at three installation positions.

r~ Page 5i;
Hoop Size:

I 100 % 100 mm hd

130 % 180 mm

180« 150 mm [Quilt Frame]

160 = 260 mm [Calar LCD)

& 160 % 260 mm [Monochiome LCD)
180 = 300 mm

—Optif 200 x 200 mm (Guilt Frame]
200 & 300 mm
| 240 = 240 mm (Quilt Frame L)

240 % 360 mm

100 = 180 mm [Border Frame)]

100 2 300 mm [Border Frame]

rColg = 1004172 mm
130 % 300 mm
: T

j.

Paj

Background

»» "Tutorial 8: Creating Design for Multi-Position

Hoops" on page 93

» Do not select a hoop size larger than the

embroidery hoop that can be used with your
machine.




Specifying the Design Page Settings

Specifying a user hoop
size

User Hoop Settings

@ — {140 140 ron MyHaopt
100 % 140 rom MyHoop2 Up 1
10 % 10 mm MyHoop3 RN | -
# 10 mm MyHoop: ]_ 6
Do 1
Delete Hoop l_I T e
o ] “width: 100 _I T Add Hoop _i T e
Height: {100 _I mm
e —— Commett:
oK | Cancel |

© Wwidth, Height
Type in the size of the hoop to be added.

e Comment
If text was entered in this box, that text
appears beside the size.

© Add Hoop
Click this button to add the hoop size.

e User Hoop List
The added hoop size appears in the list.
Select a hoop size in this list to change the
display order or to delete it.

©

Up, Down
Click these buttons to move the selected

hoop size up or down in the display order.

6]

Delete Hoop
Click this button to delete the selected
hoop size.

a

» A User Hoop cannot rotate 90°.

» A User Hoop cannot be added to the Section
Size (for Hoop Size) selector under Custom
Size.

» Do not create a Custom Hoop larger than the

embroidery hoop that can be used with your
machine.
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Changing the guideline
settings

1  Click the [View] tab.

2 Selectthe [Guideline] check box in the

[Guideline] group.

|:| Show Grid  Interval:|3.5 — Guideline
with Axes
|:| Snap to Grid

Grid [

Guideline |

3 Click aruler in the Design Page.

- G appears, and a guideline is drawn.

/

@ Guideline
* To move a guideline, drag G
+ To delete a guideline, click L:]

M

* A guideline is added each time the ruler is
clicked. In addition, up to 100 guidelines each
can be added to the horizontal and vertical
rulers.

» While a guideline is being dragged, its position is
shown in the status bar.

* When the [Guideline] check box is cleared, the
guidelines are hidden.

« If both the [Show Grid] and [Snap to Grid]
check boxes are selected in the [Grid] group,
the guidelines will be added/moved along the
lines of the grid.

»» "Changing the grid settings" on page 15




Checking Embroidery Patterns

Checking Embroidery Patterns

Zooming

1  Click the [Home] tab.

2

Click ’9\ or ‘-::3"& in the [Tools] group.

Untitled - PE-DESIGM PLUSZ

Image View

I

'-e'at Sl\a';-:'-. ||

12 Duplicats
Arrange Capy ™

[T Delete

Clip boars

QE;— Meiry
| o
Bl Eroin
Import | 5
Patterns - || TF ve £
Impart

"\ : Click the Design Page to zoom in.

Took

(Right-click the Design Page to zoom
out.)

: Click the Design Page to zoom out.
(Right-click the Design Page to zoom
in.)

Otherwise, click =| beside =/, and then

click [Zoom all], [Selected object zoom] or
[Actual size zoom].

Untitled - PE-DESIGM PLUSZ

JA & BB

Ted  shapes | [

Tools

1:1 Actual size zoom —

@ Zoom all

The entire Design Page is displayed to fit within
the window. The same operation can be
performed by clicking in the [Tools]
group.

Selected object zoom

The Design Page is zoomed to display only the
selected objects.

Actual size zoom

The Design Page is displayed at its actual size.

M

« Zooming is also possible by dragging the
[Zoom] slider in the status bar or clicking the
Zoom ratio.

* You can also zoom in or out when any other tool
is selected by holding down the <Ctrl> key while
rotating the mouse wheel.

»» "PE-DESIGN PLUS2 Window" on page 10
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Using the Pan tool

The part of the work area that is displayed can easily
be changed by using the Pan tool.

1  Click the [Home] tab.

2  Click | in the [Tools] group.
Py Untith
‘@ Home Image View
I e - - [ CY e
Select Clipboard | Taals

3  Drag the work area to view the desired part.

M

* You can also pan the work area when any other
tool is selected by holding down the <Space>
key while dragging the pointer.

» To scroll horizontally, hold down the <Alt> key
while rotating the mouse wheel.

Using the Measure tool

1  Click the [Home] tab.

2 Click %/ inthe [Tools] group.
Py Untith
‘@ Home jmage  View
. \ * __+ . E-.'"_'.L'_ul--.'nt:_ - A [g:\ oW
o r':Ltc '__.Bdc':‘ o T Sheper | ]IS
3  Click the two points, one on each end of the

distance that you want to measure.

— The length appears in the status bar at the
bottom of the window.

®
2
®
|lenglh = 67.94 mm ( Width = 60.40 mm, Height = 31,10 mm }, 333 degrees
@ Length
® Width
® Height
@ Angle
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M Realistic View

M

Click mm /in. | to switch the measurement units
between millimeters and inches.

‘ g A (% BN

x, Cut :ﬁ Duplicate

PB Copy %’%Anange Copy =

SEIvEd: [[3Paste = [} Delete Tot Shavpes &
Seled Cliphoard Toaols
Sewing Order 11 Xllll 1%

El- %% O

| & 3 ‘

You can display a realistic view of it in order to see
how the design will appear once it is sewn.

Changing the display of M

the embroidery design Changing realistic view settings
1 Click the [View] tab. 1. Click the [View] tab.
2 Click [Solid], [Stitch] or [Realistic] in the 2. Click [Realistic View Settings] in the [View

Mode] group.

"’f‘) Home Ima

[View Mode] group.

G
@ Home Image Vie

ge View

w @ iy @ @ Aralistic View Settings mI'\"-‘

—— - T " ':_Ew
e, " o
e-%g:& @ © Realistic View Settings. ||| Solid  Stitch |[Realistie |Sewmg
| | |'order !si
Solld | Stiteh Reailstic Seuing ek M
|'order 'si
Yiew Made

3. If necessary, specify settings for [Thread
M Solid View Width], [Contrast] and [Brightness], and
then click [Apply] ([OK]).

Realistic View Settings

Thread /i

Contrast
Flat '—J— Sharp

Brightness:

Dak —— }— Eright

M Stitch View

You can display a stitch view of itin order to see how
the stitching is connected.
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Checking Embroidery Patterns

Checking the stitching with the Stitch Simulator

Click the buttons to view a simulation of the stitching.

©
|

[« [ N . |
i

[V y0]y 1 [TTemss Y1 ] Yer0] Yoo O - T2 O

Simulating Stitching...|Press ESC key lIlStuD button to exit)

A
[ ] —J— ™ Auko Sexcl
DEEEET T o oo

7]

o Starts the stitching simulation. During
stitching simulation, this button changes

I
temporarily stop the simulation.

6] o

to , Which can be clicked to

()

Stops the simulation and returns to the
previous display.

The slider shows the current location in
the simulation. In addition, the slider can
be moved to change the position in the
simulation.

o

|4 |: Returns to the beginning of stitching
and stops the simulation.

#| |: Advances to the end of stitching and
stops the simulation.

(4]

Drag the slider to adjust the simulation
stitching speed.

9 Select this check box to automatically
scroll the simulation of the pattern when it
is too large to be fully displayed.

6]

Click to hide the bottom section of the
Stitch Simulator. Click to display it
again.

Shows the number of the current stitch/
total number of stitches.

WAoo Yo | ¥ 1 |: Reverses the
simulation by the indicated number of
stitches.

i +1 | §+10) Y+100: Advances the
simulation by the indicated number of
stitches.

Shows the number of the color being
drawn/total number of colors used.

O - |: Returns to the beginning of
stitching for the current or previous thread
color.

O + |: Advances to the beginning of
stitching for the next color.
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a

If the Stitch Simulator is not displayed at the
bottom of the window, click [Stitch Simulator] on
the [View] tab.

M

* The zoom tools and pan tool can be used while
a simulation is being viewed. If any other
command is selected, the simulation stops.

 If avalue is entered at 0 or e the simulation
is reversed/advanced to the indicated location.

a

« If a pattern was selected when the stitching
simulation was started, only the selected pattern
is drawn in the simulation.

* The [Auto Scroll] check box is not available in
Realistic View.




Checking Embroidery Patterns

Checking and Editing the
Sewing Order

1
2

Click the [View] tab.

Click [Sewing Order] in the [Show/Hide]
group.

Clicking the button switches between
displaying and hiding the Sewing Order.

OFF

3
S Home Image View

Urtitied

| @ Realistic Viaw Settings | |22 '%_iJ i) At
E % S 1 1
solid | Stiteh | Realistic [sewing | stiten

Order |simutatar | Rt
View Mode ShowHil

Click and @ in the [Sewing Order]
pane.

Sewing Crder o =
5 e [|CF| W
oo | G vy |

Zoom
Click to enlarge each pattern to fill its
frame.

m]

o+t@  Show by color order

Click to display in one frame all
patterns of the same color that will be
sewn together.

1 . ON 1
| »i
2 2
[
3 3
o O
4 4
»
5 ' ' 5
s}
6 6
(-
O 7
8

37

M

When multiple same color Sewngoma=r 2 x|
patterns are combined into one &) |
frame, [F] appears to the left of ;' b 1"
that frame. wio

Click to display the combined

same color patterns in separate
frames.

[=] appears under the first frame, 3
and each frame is displayed with a Q
subnumber following the first, to = a
indicate its sewing order within the
patterns of the same color.

Click [=] to recombine all of the

same color patterns back into one
frame. d

2
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M Selecting a pattern

1 Click a frame containing the pattern in the
[Sewing Order] pane.

Sewing Order n x
[E] ) & 0
Ae Gadlm %

[

|

@ Blueline
® Marching line

M

To select multiple patterns, hold down the <Shift>
or <Ctrl> key while clicking the frames for the
desired patterns. In addition, multiple frames can
be selected by dragging the pointer over them.

2 Click % in the [Sewing Order] pane to
select the pattern in the Design Page
corresponding to the frame selected in the
[Sewing Order] pane. The pattern can also
be selected by double-clicking its frame in the
[Sewing Order] pane.



Checking Embroidery Patterns

M Editing the sewing order

The sewing order can be Sewing Order o x
changed by selecting the frame 5 G || |
containing the pattern, then S | gy Gy | W
dragging the frame to the new 1 ~
location. A red line appears, »

indicating the position where the

frame is being moved. 5

The frame can also be moved by 0

clicking By, G, Gy, or Uy

in the [Sewing Order] pane.

Sewing Order

X

T
oo [ | &

b

g

a

Sew First

Click to move the selected pattern to
the beginning of the sewing order.

Sew Previous

Click to move the selected pattern
ahead one position in the sewing
order.

Sew Next
Click to move the selected pattern

back one position in the sewing order.

Sew Last

Click to move the selected pattern to
the end of the sewing order.
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B Changing colors

1

Select one or more frames in the [Sewing

Order] pane, and then click i at the top of
the [Sewing Order] pane.

— The Color pane appears in front of the other
panes.

Click the desired color in the [Color] pane.

»» "Color pane" on page 61

B Changing sewing attributes

1

In the [Sewing Order] pane, select one or
more frames containing a pattern other than a
stitch pattern.

— The sew type selector for the selected
frame appears.

Click the [Sewing Attributes] tab.

If the [Sewing Attributes] pane is not
displayed, click the [View] tab, then
[Attributes], and then click [Sewing
Attributes].

Change the sewing attributes and sew type.

»» “Line sew types”, "Region sew types" on
page 63 and "Specifying sewing
attributes" on page 63

M Displaying/hiding frames not

sewn

For details, refer to "Displaying frames not sewn" on
page 41.



Checking Embroidery Patterns

Checking embroidery
design information

Click ,P;) then [Design Property].

Most Recently Used Files

1 CWJsers\..\dog.pes

L Design Property

] oesionsetings..

Design Property

I Shory about selested Objecs)

FieName:  Unttled Design Name:
FieVersion: 100
Categoy: [
Madiied Date
widh £8.30mm Author
Height: 7950mm
Stich court: 8314 et
Sewingtine: 1B min Comment
Color changes: 6
Totdlcolors: 3
Corlist; @ Colorchanges  ( Totaleolrs
Color | Code | Brard | Desciption | Basic Color I
B =0 EMBROIDERY  RED RED
900 EMBROIDERY BLACK BLACK
800 EMEROIDERY RED FED

EMBROIDERY
EMBROIDERY

BLACK BLACK
027 FRESH GREEN  FRESH GREEN
500 EMBROIDERY  BLACK BLACK.

[iT3 Cancel

You can enter comments and information about the
pattern to a saved .pes file.
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M

The information shown in the color list can be

switched.

* Color Changes
The thread color information for each color
change is displayed. This allows you to check
the total number of thread color changes.

Caolor List & Color changes © Total colars

Coidr | Come . Erang | Description | Basic Color ]
EMEBROIDERY  RED RED
EMBROIDERY  BLACK BLACK
EMBROIDERY  RED RED
EMBROIDERY  BLACK BLACK
EMBROIDERY  FRESH GREEN  FRESH GREEN
EMBROIDERY  BLACK BLACK

* Total Colors
The thread color information for the necessary
threads is displayed. This allows you to check
the total number of thread colors.

Color List € Color changes

| Color | Code | Brand T Desenpen | Basic Coln I
1 N 200 EMBROIDERY  RED RED
2 BB 300 EMBROIDERY  BLACK BLACK,
3 027 EMBROIDERY FRESH GREEN  FRESH GREEM

M

* You can select and check the properties of
individual patterns within the embroidery design
by selecting the pattern before opening this
dialog box. In this case, clearing the [Show
about selected Object(s)] check box switches
the dialog box to display properties for all
patterns in the Design Page.

» If [Hoop Size] was set to a multi-position hoop
(100 x 172 mm or 130 x 300 mm), a [Design
Property] dialog box appears with the sewing
information for each hoop of the pattern in the
Design Page.

Design Property
About haop posiion 1 /2
I Show about selected Dbjec(s).
FigName:  Uniitled Design Name
Fie Version: 100 -
Modified Date S
Widh 13000 Author
Height 180,00
Stich count: 5603 et
Sewingtime: 11 min Comment
Cokr changes: 4
Totslcolors: 2
Color List  Colorchanges (" Total calors
Color | Code | Brard | Desciption | Basic Color I
1 M 500 EMBROIDERY  RED RED
2 M 900 EMBROIDERY  BLACK BLACK
3 M 500 EMBROIDERY  RED RED
4 B 500 EMBROIDERY  BLACK BLACK
i3 Cancel




Tutorial 5: Creating Embroidery Patterns From a Vector File

Tutorial 5: Creating Embroidery Patterns

From a Vector File

An embroidery pattern can be created from an image, such as photo or illustration. WMF, EMF and SVG image

files can be converted to embroidery patterns.

The sample file for this tutorial is located at:

Documents (My documents)\PE-DESIGN PLUS2\Tutorial\Tutorial_5

Step 1 Importing vector images (SVG files)
Step 2 Displaying frames not sewn
Step 3 Decorating the outer heart shape

Step 1 Importing vector images
(SVG files)

Vector image data in the ".wmf" (Windows Metafile),
".emf" (Enhanced Metafile) and ".svg" (Scalable
Vector Graphics) file formats can be converted to
shape patterns.

1  Click the [Home] tab.

2 Click [Import Patterns] in the [Import] group,
and then select [from Vector Image].

Untitled - PE-DESIGN PLUIS2

s @[ Syl 2

s
Is e
£[ trom Desigrs Librar.
| e trom Fike. = e
———————| 45 tom vectus Image. —| ~ |5 impon FEE1 color Hoveml
I
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Select the file to be imported, and then click

[Open].
For this example, we will import
[svg_heart.svg].

Dpen # vector file

Lok e actor rnage = = @ rf -
* b L =
= Ve e|e
Cesine N7 Nl
= e sacket g s greenfoat Seheat
Lindes
L] ks
s e 1 ¥
¢ & '
Mok
saship sohal wmibhetn e fes
Fages: foptee I (|
Fincitpe:  [itor Fea " ool gl -] oo

€

*

F Puisn

— The image appears in the [Design Page]

as a shape pattern.




Tutorial 5: Creating Embroidery Patterns From a Vector File

Ly tited - PE-DESKGN FLUS

Mty Ouevion = B F v
S 0 Aot

e ———— i —r—— -

» Image, text, width of the line, gradient, opacity,
and any other styles or attributes of graphics will
not be imported. With files in the ".emf" and
".svg" formats, the data is converted while
retaining curves.

» The data on all layers of an SVG file, regardless
of whether it is displayed or hidden, will be
converted into the embroidery pattern.

Step 2 Displaying frames not
sewn

1  click|L.!|in the toolbar at the top of the
[Sewing Order] pane.

x Hide Objects Not Stitched
Click to display hidden objects that are
not to be stitched.
ON OFF
7 [cH = gt =
S | Gy G | W o | i b | W
fn fn

41

M

* Frames containing patterns that will not be sewn
can be displayed or hidden.

» As a default, frames containing patterns that will
not be sewn will be hidden.

* When frames containing patterns that will not be
sewn are displayed, that frame can be selected
and its pattern can be edited.

Step 3 Decorating the outer heart
shape

1 Select the colored area of the heart shape,
and then click [Shapes] tab.

‘; \  Unteled - PE-DESIGN PLUS2 _ Shapas
"--'j Home  Imags Vi | Shage:
P

"

[Sele|

i o
—

| et |_eanpunt_T
Ui B el =
. L )

2 Specify a color and sew type for each shape

as follows.

Line sew

» Line sew type : Motif Stitch

* Line color : SALMON PINK
Region sew

* Region sew type : Prog. Fill Stitch
* Region color : DEEP ROSE



Tutorial 5: Creating Embroidery Patterns From a Vector File

3

Click the [Sewing Attributes] tab, and then
specify the following settings.

Sewing Atributes o x
2 ]import & Color | (8 Sewing »:...l AB Tet Attrib...
FLing sew

VBegion sew
¥ Under sewing
[#8" =] lnesrm

Densily

Direction
& Manual

a5 3_ degrees
 Aulg
Pull =
compenzation [p0 o

VProgiammable Fill

él@ 60 =

Line sew

* Motif pattern : mot023 ;«1?

* Motif size : 4.5 mm

Region sew

* Under sewing : ON

» Density : 4.8 line/mm

« Direction : Manual, 45 degrees

e Pull compensation : 0.0 mm

* Programmabile fill
- Fill stitch pattern : pat012 @
- Pattern size : 6.0 mm

[l e | 2
GEN | |h

L |
&

(i
[}
[}
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4 Inthe [Sewing Order] pane, drag frame 2
(heart shape outline) to the top (above the
outer heart shape).

LA |
oa | g e | &

Change the sewing attributes for objects that
are not to be stitched as desired.

M Creating an embroidery pattern
using vector images drawn with
other image-editing applications

Being converted to the ".svg" file format, vector

image files created with other commercially

available applications (e.g., ".ai" (Adobe lllustrator

Artwork) and ".cdr" (CorelDraw file)) can be

imported.

First convert the vector image files into either of
WMF, EMF or SVG file format with your
applications, and then import them to PE-DESIGN
PLUS2 by following the steps described in
"Importing vector images (WMF/EMF/SVG)".

M

Raster image files (e.g., ".bmp" and ".jpg") can be
used as background images in PE-DESIGN
PLUS2, or they can be converted to embroidery
patterns using the Image To Stitch Wizard.

»» For details, refer to "Creating Embroidery
Patterns Using Images" on page 73.




Opening/Importing Embroidery Designs

Opening/Importing Embroidery Designs

Creating a new embroidery
design

Click (£, then [New].

Most Recently Used Files

1 ChUsersl..\dDg.pes

The size of the Design Page can be changed.

»»  "Specifying the Design Page Settings" on
page 32

Opening a PE-DESIGN
PLUS2 file

1 Click (&, then [Open].

Most Recently Used Files

1 CAUsers\..\dpg.pas

2  Select the drive, the folder and the file, and
then click [Open], or double-click the file's

icon.
File Opm =
ke [R5 +ECE
* #3000 - ” -e #
Qukosows | BEONT ‘}‘} "
] 1
[ ez e v 3
Destrg  3mmzT
= 0
0T F Fusisa
Lindes
)
iy w0 =]
TheRr SOOI
e
E 4 E N
s I
Iy -
Finarsa: 1310ec2s = I o |
Fina o trpac [Entruer; Rer FES) = T
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M

» To view the data in the selected folder as
thumbnails in the [Browse] dialog box, click
[Browse].

Browse

33100227 pes 33100306bupes 33100306c.pes 33100525 pes

33100527 pes 33101615apes 33101621 pes  33102525apes w
< >

| Preview... || Cancel |

» To see a more detailed design, select a file, and
then click [Preview].

Preview

Cancel

» To open the displayed file, click [Open].

« If nofiles are listed, there are no .pes files in the
selected folder. Select a folder containing a .pes
file.

« If the selected file is in a format other than the
.pes format, the message "Unexpected file
format" appears in the [Preview] window.

M

A file can be opened in any of the following ways.

» Drag the embroidery design from file Windows
Explorer into the PE-DESIGN PLUS2 window.

» Double-click the embroidery design file in
Windows Explorer.




Opening/Importing Embroidery Designs

a

If a .pes file created with PE-DESIGN 10 or earlier
is opened with this software, the message “This
file will be imported into a new Design Page.”
appears before the embroidery design is displayed
on the new Design Page.

Importing embroidery
designs

Embroidery designs can be imported from the
[Import] pane. For more details on the [Import]
pane, refer to "Example of Importing Embroidery
Data" on page 13.

B From Design Library
1  Click the [Home] tab.

2 Click [Import Patterns] in the [Import] group,
and then click [from Design Library].

Urtitled - PE-DESIGM PLUS2

T. e HI e -
A Eﬁ;\ @, Gy | =N %, Madify Overlap
Tt Sh L | i croum ~

= apes s Impart

- : ﬂ % Pittsrns' El Move to Centes
Toals Imoort

£] trom Design Library... |

B , , , , 19 ﬁ from File...

@ trom vector image...

3  Fromthe [Category] selector, select a

category to display the corresponding
embroidery data.

Import B ox

i ]import | i Color ifiSewing At... ABText Attrib...

From IDes\gn Librany LI
Categary Floral ;I
[A
Borders & Banners

g

e

F00110.pes 33100117 pes 33100225 pes

I3100226.pes 33100227 pes  33100306b.pes

4  Select the file icon for the design to be
imported, and then click [Import].
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M From a folder
1  Click the [Home] tab.

2 Click [Import Patterns] in the [Import] group,
and then click [from File].

Untitled - PE-DESIGM PLUS2

. ST = ) Madify Qverlap =
A & |aaE ?D“r

Text  Shapes g Impart
- - () Patterns +||| & Move to Center
Tools Import |
£3| from Design Library...
o ) ) ) jo, |EJ fromFie..

4| from Vectar Image...

. u

3 Click =
Impaort o x

i:import | I color i sewifig At.. ABText Attrib...

Fram IFDIder ;I

Flle T_l,lpe C:\Program Files (x86]%...\Misc

4 S #

01114 pes 33101622 pes 33101623 pes

A %

33101629.pes 33101642 pes 331017264 pes

@ Indicates the path to the currently selected
folder.

4  Select afolder, and then click [OK].

Browse for Folder X

v PE-DESIGN PLUS2 ~
¥ Clipart
Color
Font
w Library
v Design Library
Borders & Banners
Floral
Misc
S Qutline Shapes




Opening/Importing Embroidery Designs

5 Click[File Type] in the [Import] pane. Select
the file name extensions of the corresponding
embroidery data to be displayed, and then
click [OK].

File Type

V¥ PES ¥ PHC ¥ DST ¥ ExP [¥ PCS
W HUS W WIP ¥ SHY ¥ JEF [ SEw
¥ 05D W ¢ [ PEC

(1]:4 I Cancel |

6  Select the file icon, and then click [Import].

a

When importing designs from other vendors, be
sure to choose a design that will fit in the Design
Page.

M

Since .dst files do not contain thread color
information, the colors of an imported .dst file may
not appear as expected. You can change the
thread colors by using functions in the [Sewing
Order] pane.

»» "Changing colors" on page 38

* When importing .dst files, the number of jump
stitches for thread trimming can be specified.

»» "Specifying the number of jumps in
embroidery design of the DST format"
on page 102
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Saving and Exiting

Saving and Exiting

3 Click [Save] to save the data.

— The new file name appears in the title bar of
the PE-DESIGN PLUS2 window.

Saving

M Overwriting

Click m;j then [Save]. EX|t|ng
@l Click (4, then [Exit].
D Hew Most Recently Used Files
@ . 1 CUsersy.\dog.pes ﬁ S
‘ E Save g . 1 CiUsersy.dag.pes
E Save As... E Save :
&L, g i [ o =

m 2 meston ropeny

If no file name has been specified or if the file (] ovon s
cannot be found, the [Save As] dialog box ] s
appears. (&5 ovvom: ]

Hl Saving with a new name

1 Click (£, then [Save As].

D Hew Most Recently Used Files
1 CUsersy.\dog.pes

@ Dpen..

E Save

‘E Save As..,

L] Print »

2  Select the drive and the folder, and then type
in the file name.

Save s 3
swmin [PECERENFLEZZ =] + @k B
Hams - Dats moditied s
ik e Sample $202/2016 2058 Filefolder
- Tutorad $202/2016 2058 Filefolder
Dissking
"
Lbsss
Tha F
Metworkc
Fla g L = e |
TR [PEDESIGN PLUSZ Flal" PES) vl Carcel
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Printing

Specifying print settings

Before printing, you may need to change the print
settings for the embroidery design files.

1 Click ,Py then [Print], then [Print Setup].

s Untitled - PE-DESIG
|— Y Preview and print documents
Hlew
[, Bt
. [F) Prints yaur emaraidery design and image.
=L
1. Print Preg
) :.{ Displays a preview of your embroidery design [
Save and imans hafars anntine
Ty Print Setup =
E Save 4. {3} Changes the printing settings for a previewed
T ambeaidary design and image.
| b prine v
=
|_—!‘_' Dwesign Property
Print Setup
Name: Micre Froperti
Status: Ready
Type:  Microsoft KPS DocumentWier v
Where: PORTPROMPT:
Carmment:
]
o ] s e = & Porait L e
Source:  |Automaticaly Select - " Landscape
Pt wp Frint op
I Print sewing area bow & center awes
I Fiint template giid | e
F Divide into 2 pages.
- Sttch image I Colr changes
6 1 & Nomal
€ Realitic b |
Network Pirt.. | Piint Preview | oK | Cancel

o Specify the paper size.
e Specify the paper orientation.

9 Print type

Actual Size:
Select this option to print the design at
actual size and the sewing information
(dimensions of the embroidery pattern,
sewing color order, stitch count and
hoop position) on separate pages.

Reduced Size:
Select this option to print a reduced
image together with all of the above-
mentioned information on a single
page.
e Print option
Print sewing area box & center axes:

Select this option to print black lines to
indicate the sewing area and the
center axes for the data. (This setting is
only available when [Actual Size] is
selected.)
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a

Print template grid:

Select this check box to print green
lines to represent the grid printed on
the embroidery sheet included with the
hoop. (This setting cannot be selected
if [User Hoop] has been selected as
the Design Page size.)

Divide embroidery image into 2 pages:

Select this check box to print at actual
size and on A4- or Letter-size paper a
design that is larger than the paper size
by dividing it in two and printing each
half on different pages.

(This setting is only available when
[Actual Size] is selected in the [Print
Setup] dialog box and when the
Design Page is set to the larger hoop
sizes. This setting is not available if a
[User Hoop] size is selected.)

With this split printing feature, ™ / {gt
or .] / EI is printed in the lower-right
corner of the paper to indicate which
half is printed.

Color Changes:

Select this check box to print the thread
color change information for the
pattern.

When this check box is cleared, the
information for the necessary threads
is printed. This allows you to check the
total number of thread colors.

9 Stitch image
Normal:

Select this option to print the design as
lines and dots.

Realistic:

Select this option to print a realistic
image of the design. To change the
settings of the realistic image, click
[Attributes].

»» "Changing realistic view settings" on
page 35

If the [Divide embroidery image into 2 pages]
check box is cleared and you print on paper of a
larger size, the design does not print in two halves.
Likewise, if you print on paper of a smaller size, the
design might be cut off.




2

Click [OK].

»»  "Changing the display of the embroidery

design" on page 35.
Checking a print image

You can preview the contents of the Design Page
before printing.

Click (), then [Print], then [Print Preview].

=N Untitled - PE-DESIG
] mew

= oren

H--

Freview and print documents

I'II.?I Print

Prinks your embroidery design and image.

. Print Preview
|l i Displays & preutew of yaur embraldery design
and image hefare printing.

L=

Ty Print Setup

B SAVE AS... g Changes the printing settings Tor a previewed
embroldery design and Image.
"‘L‘L Erint v

T
+L Design Fraperty
| an ropery

M

The print image can also be displayed by clicking
[Print Preview] in the [Print Setup] dialog box.
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Printing a Design Page
with sewing information

You can print the Design Page together with its

sewing information.

1

2

3
4

Click (), then [Print], then [Print].

Untitled - PE-DESIG

] Print
[ l_l--| Frints your embroidery design and image,

. Print Freyiew

{2, Displays 2 preview of your embraidery design w
and image before printing.

L

-, Print Setup
{3} Changes the printing settings for  prevewsd
i design and image,

T
| +l Design Property
=l

Select the necessary settings.

Print x
- Prirter
[V Microscft %PS Document Witer - Properties
Status: Ready
Type:  Microsoft XPS Document Wiiter v4
Where:  PORTPROMPT:
Commert: I™ Print to fle
Pt rang Copi
@ Al Nomber of gopies: 1 =]
" Pages from: |1 tor)2
913 213 F Callate
1 Selection 1] 1]
s

Click [OK] to begin printing.

Follow the instructions for the printer to finish

printing.



Drawing Shapes and Reshaping

Drawing Shapes and Reshaping

Drawing Shapes

M Drawing rectangle or circle shape

@) X&

Oval

Rectangle Circle

1  Click the [Home] tab.

Click [Shapes] in the [Tools] group, and then
click a tool icon under [Rectangle]/[Circle] to
select the desired [Rectangle]/[Circle] tool.

Untitled - PE-DESI(

IES =S ;’—_TL
Snapes| | [ G Impart

Pattems~

o[ Getete
Ciipboard

‘ Select

_Seie(\ L | Outline IP°__
OB H&ER u = g & < .
S e L & < SR
[ S a5 r e —
B | b | R | ‘ | | L | (_')

[:] : Rectangle with rounded corners

O : Circle or Oval
a

To draw a circle or square, hold down the <Shift>
key while dragging the pointer.

Drag the pointer in the Design Page.

>
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M

Rectangles with rounded corners

» To change the radius of the corners, click the
[Edge radius] selector in the [Outline] tab.
Then, type the desired radius, or select the
desired value.

» Specify the radius of the corners before drawing

the rectangle. The setting cannot be changed
after the rectangle has been drawn.

."’_\) Urttitled - PE-DESIGN PLUSZ | Shapes
.l‘f‘-) Home Image Viewr Outline
_l_ |- wweneree Zigzag Stitch -
s;c Ei h”-A {EEEEEEE P stiten ‘
_Seleat ||| ijL- W Sems
CUEE oo I
Sewing Or( 20.0 . [ —
[ %55 s00
S | (g 4 500 - ‘
Example 1 Example 2

Edge radius: 0.0 mm Edge radius: 20.0 mm

B Drawing outlines (straight lines
and curves)

End point
Start point
Open line Closed line
End point
Start point
Open curve Closed curve



Drawing Shapes and Reshaping

1  Click the [Home] tab.

2 Click [Shapes] in the [Tools] group, and then
click a tool icon under [Outline] to select the
desired Outline tool.

Untitled - PE-DESI(
E‘{\: e e EL |
[ s e
____ [ Outiine port |
Sewingovder  n W w8 Le = J ee s
ST | o T Rectangle/Circle [
. A‘ E@®

g : Click points to draw a closed line
constructed of straight lines.
(Shortcut key: <Z>)

Cb : Click points to draw a closed curve.
(Shortcut key: <X>)

S . Click points to draw an open line
constructed of straight lines.
(Shortcut key: <Z>)

\_,P : Click points to draw an open curve.
(Shortcut key: <X>)

3 Clickinthe Design Page or drag the pointer to

draw the line.

M

The shortcut keys are available only after an
Outline tool has been selected.

M Straight lines/curves

1  Click in the Design Page to specify the start
point.

2  Click in the Design Page to specify the next

point.

=

— The dotted lines change to solid lines.

M

* To remove the last point that was entered,
right-click the mouse button, or press the
<BackSpace> key.

* The Curve tool is used in the same way.
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3

Continue clicking to specify every point, and
then double-click the last point, or press the
<Enter> key.

M

* You can freely switch between the different line
types either by clicking a different button or by
pressing the shortcut key.

* When drawing a straight line, hold down the
<Shift> key while moving the pointer to draw
vertically or horizontally.

» Even after the pattern is drawn, you can change
the attributes of line ends.

»» "Changing the attributes of line ends" on

page 50.

» Even after the pattern is drawn, you can
transform straight lines into curves and vice
versa.

»»  "Transforming straight lines into curves or

curves into straight lines" on page 52.

B Changing the attributes of line
ends

>

After selecting a shape pattern, right-click it, and
then click [Open] or [Close] to change the line
ending.

o . 1= L L L L 1 [ = = "

= et Ti0TaG Stitch il

1 L]
L] L]

\a0




Drawing Shapes and Reshaping

Reshaping Embroidery
Patterns
Patterns can be reshaped by moving, adding or

deleting points. While creating shape patterns, a
clicked location becomes a point.

M Selecting points
1  Click the [Home] tab.

2 Click [Select] in the [Select] group, and then
click ’?} to select the [Select Point] tool.

;G_.‘\ Untitled - PE-DESIGM PLUS Shapes
ey
- —) Home Image View Shapes
z —
Y ’f‘ § A B s
= 1Ca e
Seledt Tewt  Shapss iy
| - | ﬁ Cielete - - £
Select Tools Clipboard Taals
% I|/—-;i:|:r T
35 ':'_'] ' s i i

3 Click the shape pattern.

To select a single point, click an empty square.

Multiple points can be selected in any of the
following ways.

» Drag the pointer.

— All points within the box are selected.
» Hold down the <Ctrl> key while clicking the
points.
— To deselect a point, click the selected
point.
* Hold down the <Shift> key while pressing an
arrow key to select multiple points.

* Hold down the <Ctrl> key while pressing an
arrow key to change the point that is selected.
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M Moving points
1 Select the point.

2 Drag the point to the new location.

a4

Selected point

M

» To move the point of a broken line, a curve, or
stitch data horizontally or vertically, hold down
the <Shift> key while dragging it.

» A selected point can also be moved with the
arrow keys.

» Points in patterns set for hole sewing can also
be moved. However, the point cannot be moved
to cross an outline. In order to move the point in
this way, cancel hole sewing first.

« If you start dragging by clicking elsewhere on the
outline of the pattern, a new point will be inserted
or the selected point(s) will be deselected.

M Inserting points
1  Select the [Select Point] tool.

2  Click the shape pattern.

3  Click the outline to add a point.

Click

=



Drawing Shapes and Reshaping

M Deleting points
1 Select the point.

2
3

Click the [Shapes] tab.

Click [Delete Point] in the [Edit Point] group.
Otherwise, press the <Delete> key to remove
the point.

"% Unfitled - PE-DESIGN PLUSZ | Shapes
)
Home Image View Shapes

T || LA Edit Paint 7| =
fy 0 » wanaanis Zigzag Stitch
L e
Select | L -
Select || Edit Pairt ‘ sen

Delete

=

Selected point

B Transforming straight lines into
curves or curves into straight
lines

1 Select the point.

2  Click the [Shapes] tab.
3 CcClick [Edit Point] in the [Edit Point] group,
and then click [To Straight] or [To Curve].
i’ ‘T Untitled - PE-DESIGN PLUS2 | Shapes
k Home Image Wiew Shapes
| /" Edit Faint ']Illiv Zigzag Stitch
e = :;p;-aiort :
| Select || Ta Curve Sew
D g H Curve Type
Sewing Ord S e 0 fo . . .
lE‘ l‘E!\ To Symmetry
E" 2 To Cusp
To Curve

=
| <=

To Straight
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B Changing the curve type

1 Select a point on a curve.

2  Click the [Shapes] tab.

3 cClick [Edit Point] in the [Edit Point] group,
and then click [To Smooth], [To Symmetry]
or [To Cusp].

/% Unfitled - PE-DESIGM PLUS2 | Shapes

.!-P—‘) Home Image Wiew Shapes

(F; /™ Edit Poink '] i Zigzag Stitch

Line Type

| o T:pst'aiul-t )

| Seleet || To Curve Sew

ﬁ g E Curve Tune

sewing Or Ta Smoath ||5,n . A A .

@ |1E‘\I To Symmekry

lﬁl" (IEI Ta Cusp
To Smooth

f\)\
To Symmetry
To Cusp
=

& & S
4  Drag the solid black handle to adjust the

shape of the line.

M

The shape can be changed by dragging the solid
black handle on either side of the point.




Editing Embroidery Designs

Editing Embroidery Designs

Selecting patterns
1  Click the [Home] tab.

2 Click [Select] in the [Select] group, and then

click | & .
" Unfitled - PE-DESIGM PLUSZ | Shapes

!@ Home Image WView Shapes
A%

Text  Shapes

k HKocut  EFpupiicate
Gy copy & Amange Copy -
i Pasts [} Delate

3 Clickthe pattern.

@ Rotation handle
® Handles

M

The status bar shows the dimensions (width and
height) of the pattern.

4 To select an additional pattern, hold down the
<Ctrl> key and click the other pattern.

M

* You can also select patterns by dragging the
pointer across the pattern.

» Press the <Tab> key to select the next patternin
the order that they were created.

« If multiple patterns are selected, a pattern can
be deselected by holding down the <Ctrl> key
while clicking the pattern.

M Selecting all embroidery patterns
1  Click the [Home] tab.

2 Click [Select] in the [Select] group, and then
click [Select All] to select all patterns.

Untitled - PE-DESIGMN PLUS2 Shapes

¢ )
’.—-/I Home Image WView Shapes
Y Hcut ESnupiicate A @

1 Cii Copr Amranges Copy
5,|¢¢| Fcoer 9% < 5 Tet  Shapes

i Pasts [} Delate
SelectTool | Clipboard || Teal
| A B s _
-‘ R e Pp———
| serect il [[£ | W -PL-| ,7

M

All patterns can also be selected by pressing the
shortcut keys <Ctrl> + <A>.

Moving patterns

B Moving manually
Drag the selected pattern(s) to the desired location.

M

» To move the pattern horizontally or vertically,
hold down the <Shift> key while dragging it.

» Pressing the arrow keys moves the selected
pattern.

* Holding down the <Ctrl> key and dragging the
pattern creates a duplicate of the pattern at the
destination.

B Moving embroidery patterns to
the center

1 Select the pattern(s), and then click the
[Home] tab.

2 Click [Move to Center] in the [Edit] group.

Modify Overlap = &) Flip ~ D
0 Rotate... Q;B ’j‘@ '@

%t Group ~

. Applique|| Export Send
[fi Move to Center| ER] size.. Wizard || FCMFile || =

Edit Appligue || ScanNCut Sew




Editing Embroidery Designs

Scaling patterns

M Scaling manually
1 Select the pattern(s).

@ Handles

2  Drag the handle to adjust the selected

pattern(s) to the desired size.

« If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.

* As you drag the handle, the current size is
displayed on the status bar.

» When scaling stitch patterns, the number of
stitches remains the same, resulting in a loss of
quality. To maintain the density and fill pattern of
the embroidery pattern, hold down the <Ctrl>
key while scaling. Even stitch patterns with a
non-uniform stitch density and needle drop point
pattern can be scaled while maintaining the
density and fill pattern.

» "Enlarging/Reducing Stitch Patterns” on

page 104.

3 Specify the size, and then click [OK].

Size

\Width
o |1nn

Height
jl ” I‘IDD

i
;I/o

illmm

jl . |3a.n

© ——— Keep density and fill pattern

Ok I F'leviewl Cancell

@ Sclect the whether the width and height
will be set as a percentage (%) or a
dimension (millimeters or inches).

Set the width and height.

To change the width and height
proportionally, select the [Maintain
aspect ratio] check box.

2]

©

To resize the selected pattern while
maintaining the original density and fill
pattern, select the [Keep density and fill
pattern] check box.

M

The [Keep density and fill pattern] check box is
available only if stitch pattern is selected.

»» "Enlarging/Reducing Stitch Patterns" on

page 104

M Scaling numerically

1 Select the pattern(s), and then click the
[Home] tab.

2 Click [Size] in the [Edit] group.

Modify Overlap = E,) Flip =
O Rotate...

Eﬂ- Move to Centerl |D|_q Size... |
Edit

A

Export Send
FCM File v

Sew

%t Group ~

Appligue
Wizard

Appligue || ScanNCut
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Rotating patterns

M Rotating manually
1  Select the pattern(s).

2 Drag the rotation handle.

o The shape of pointer changes to {)
e Rotate

@ Rotation handle



Editing Embroidery Designs

M

To rotate the pattern in 15° increments, hold down
the <Shift> key while dragging the handle.

B Rotating numerically
1 Select the pattern(s), and then click the

[Home] tab.
2 Click [Rotate] in the [Edit] group.
Modify Overlap = &) Flip ~ Q;; F D
— Group ~ I |\_) Rotate...| _ [P '@
@- Move to Center |_—| Size... A&?leac:ze Faﬁ?:ﬁe Sevnd
Edit Appligue || ScanNCut Sew
3  Type or select the rotation angle. Click [OK].

Rotate

@ IE1 1 deges

OF | F'reviewl Eancell

M

An angle can also be selected by dragging @ in
the [Rotate] dialog box.

Flipping patterns
horizontally or vertically

1 Select the pattern(s), and then click the
[Home] tab.

2 Click [Flip] in the [Edit] group, and then click

[Flip Vertically] or [Flip Horizontally].

Modify Overlap [ Flip-= | |_—‘ﬁ
{5} Group ~ B2 | Flip vertically @ '@
Export Send

@' Move to Center || 23 | Flip Horizontally ECM File -

Edit ]I Apphgue ]| ScanMCut Sew
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Mirror Copies

For details, refer to "Using the mirror copy tool" on
page 28.

Grouping/Ungrouping
embroidery patterns

B Grouping patterns

1 Select several patterns, and then click the
[Home] tab.

2 Click [Group] in the [Edit] group, and then

click [Group].

Cole [IF 5 Modify Overlap ~ &) Flip ~
(@ Cul]|| By || @ Modity Overiap ~ £ Fiie
> | 5} Group v| 0 Rotate...
|{M|" %' Import Tt o
pattems - |||} _Group [Ir Bl size..
5 Import UnGroup Bt

B Ungrouping patterns

1 Select grouped patterns, and then click the
[Home] tab.

2 Click [Group] in the [Edit] group, and then

click [Ungroup].

= [P , Modify Overlap = &) Flip ~
[Qem)| By (2 :
> 2 Rotate..
|{M|,' %| Import = —F s
Patterns~ (|| et | Group T R Size..
E Import uUnGroup |t




Editing Embroidery Designs

M Editing grouped patterns
individually

Even after patterns are grouped, they can be edited

individually.

1 Toselecta single pattern within a group, hold

down the <Alt> key while clicking the pattern.

2  Edit the pattern.

Hole sewing

By specifying hole sewing, the stitching in
overlapping regions will not be sewn twice. Hole
sewing can be set only when one region completely
encloses another.

Embroidery patterns created with the Shapes tools
can be selected to set hole sewing.

Y2y

Hole sewing not set

@ ®

]

Hole sewing set

@ Sewn twice
® Sewn once

1 Select a pair of patterns, for example, a star
included in a pentagon.

While holding down the <Ctrl> key, click the
star, then the pentagon.

@ Invalid

a

Hole sewing cannot be specified with the following
shape patterns.

« Patterns with an intersecting outline.
« Patterns with multiple sewing direction lines.
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2
3

Click the [Home] tab.

Click [Modify Overlap] in the [Edit] group,
and then click [Set hole sewing].

EwreE il E (% Madify Overlap v]lg,; Flip =
Remove/Merge jotate...
lﬁ %l p;;.nt::jnr:. @ | Remove Overlap ze...
5 Import @5 | Merge
Hole sewinag —
|0 ) |{@)  Set hole sewing |
~

M

To see better what the hole sewing setting does,
preview the patterns before and after setting hole
sewing.

»» "Stitch View" on page 35

B Canceling hole sewing

1 Select a pattern that has been set for hole

sewing.
2  Click the [Home] tab.
3 Click [Modify Overlap] in the [Edit] group,

and then click [Cancel hole sewing].

e T Modify Overlap |3, Flip -
A Ty (R nor

+D Remove/Merge intate...

Import - ~
lﬂ %l Patterns~ Ze...
s Import erge
Hole sewing
|0

Set hole sewing ;
| Cancel hole sewing " -~



Editing Embroidery Designs

*« When enclosed

Changing shapes of
overlapped patterns

Embroidery patterns created with the Shapes tools
can be selected to remove overlapping regions or to
be merged. . »

B Removing overlapping

Overlapped patterns can be set so that the
overlapping region is removed.

First pattern in the sewing order

Second pattern in the sewing order

Third pattern in the sewing order

1  While holding down the <Ctrl> key, click two
or more overlapped patterns to select them. [ | Merglng
2 Click the [Home] tab Overlapped pattern can be merged together.
3 CcClick [Modify Overlap] in the [Edit] group, / >
and then click [Remove Overlap]. p /,,/7 P 2 W///%

_

% Modify Overlap v|§,; Flip =
————— vy — The color and sew type of the last pattern

L | [ r——— . drawn (topmost pattern) is applied to the
merged pattern.

Import b | Merge
Hole sewing
|o ) @ Set hole sewing

While holding down the <Ctrl> key, click two
or more overlapped patterns to select them.

of |

2  Click the [Home] tab.
*  When partially overlapped
3 CcClick [Modify Overlap] in the [Edit] group,

and then click [Merge].

% Modify Overlap = |},J Flip =

Remove/Merge otate...

Import
Patterns - ||| “& | Remove Overlap ze...

Import ||} S Merge |
Hole sewing
|o ) @ Set hole sewing

<
o 4

o

nole sewing -~

— If this cannot be applied to the selected
patterns, an error message appears.
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- - ¢4 Untitled - PE-DESIGH PLUS2 | Shapes
Creating an offset line N —_
o cut B pusiicate T |5 || B
pattern E 5 Cony a“;nrr:nqecom- A ‘E—'p ESENER) |y 4 Group »
S| Erspste 3 et T snes [y it | B More t0
Line stitching in a concentric pattern can be created e = ==
based on the selected shape. Ein%o-;-lz nix S S —— ———
B a8
F
e
1 Draw a shape, and then select it.
& Offset Direction
Be sure to select one closed line. Outward Inward

»» "Changing the attributes of line ends" on
page 50

2  Click the [Shapes] tab.

3 CcClick [Create Offset Lines] in the [Edit]

grotp- Spacing
Y Intitied - PE-DESIGN PLUS2 Shapei
5 :;.. Image  View Sha:(s 1 mm 5mm
: ':' B s Digzag Biich :
[[Select] B~ ] hot Seum Ragiary
Selest Edit Paint Sowr
e B SEE i =
.". ) o | | L
- : -
L] - ;
Offset Line Count
| . . - 1 line 5 lines
{)
AN
) —=~

—

4 Specify the desired settings for the offset line
pattern, and then click [OK].

Offset Line Settings
Offset Direction; Rounded Corners
~ D

Spacihg: I 5-D_|:: mrm

" lrward Check box selected. Check box cleared.

A

A
A\
= — N
Dffzet Line Count: I 1;| . == .

[~ Rounded Carers

ak I Preview | Cancel
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Editing Embroidery Designs

Exporting an FCM File for
ScanNCut (Brother cutting
machine)

A created embroidery pattern can be exported as
data in the .fcm format so that it can be cut out using
the Brother cutting machine (ScanNCut).

0 K& '

» Embroidered fabric cannot be cut with the
ScanNCut machine.

» There are limitations on the thickness of fabric
that can be cut by the ScanNCut machine.

» For details, refer to the Operation Manual for the
Brother cutting machine (ScanNCut).

1 Select the pattern(s), and then click the

[Home] tab.
2 Click [Export FCM File] in the [ScanNCut]
group.
- O X
Option i'

e | e
0 Rotate... [P
Applique ||| Export Send

Bl size... Wizard | [FCM File -
Appligue || ScanMCut Sew

3 Specify the desired settings for the cutting
line, and then click [Export for ScanNCut].

Expeet FCM FilaFor ScanhiCist ®

7 Comstna cutingine o meand s e e
e ece.

[

CutingDatadios  1000] § E7.] ™" o
Ll —— e

S
——

o Offset Spacing
Specify the distance from the outline of
the pattern to the cutting line.

« If [Offset Spacing] is set to 0.0 mm,
the outline of the pattern will become
the cutting line.

>

» If [Offset Spacing] is set to any setting
other than 0.0 mm and the cutting lines
overlap, they will be merged.

e Select this check box to draw the cutting
line only around the outer edge of the
pattern. Clear this check box to also draw
cutting lines inside the pattern.

ON OFF

9 Export for ScanNCut
Click this button to display the [Export
FCM File] dialog box, where the
destination for saving the file can be
specified.

9 Cutting Data Size
Displays the size of the cutting data.

6 Display Template
Select this check box to display a faint
image of the original pattern.

@ Close

Click this button to close the dialog box.
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M

« If characters in a text pattern overlap, they will
be merged.

ABC » /50

However, if [Offset Spacing] is set to 0.0 mm,
the overlapped patterns may not be merged.

» Extremely small data will not be exported.

» The maximum size for cutting data fits within a
12 x 12 inch (305 x 305 mm) mat. If this
maximum is exceeded, an error message
appears.

* A maximum of 100 .fcm files can be created at
the same time in the [Export FCM File] dialog
box. If this maximum is exceeded, an error
message appears.

4  Select the drive and the folder, and then type
in the file name.

Export FCM Fils ®
Smve: [ PEOESEN PLUEZ ¥ - E ok E.
* Marne - Date mediied Type
Sanple CE/OEIGIRIE  Filetokder
Tutorial CRM22016 2058 File folder
Desdnp.
[}
Liries
Thia P
Hetvodc
< :
Fa gana [uresica =l Save
Save astpe: | ScanNCut " fon) hd Canca

5 Click [Save] to save the data.
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Specifying Thread Colors and Sew Types for Lines and Regions

Specifying Thread Colors and Sew Types

for Lines and Regions

Setting the thread color

The [Sew] group in the [Shapes] tab allows you to
set the thread color of shapes.

|
<% Untitled - PE-DESIGN I|Lus2 Shape:
'f N
»_.'J'J Home Image View Shapas

" Eclit Paint =

Setect

e Tigeng Stitch -

|g|_;| FTHRIERR] it siten
|

Delete Foint
Edit Point

@ Line color
® Region color

M Color W~

Click the [Color] button, and then select the desired
color from the list of thread colors.

ﬂ_\\ Untitled - PE-DESIGN PLUSZ Shapes
Home Image iewr Shapes
~ =
bt Paine i' sy Tigzag Stiteh v |
"% Delete Pa
Sc|((f clete Poins EROTHER EMBROIDERY — o
| (AN AR
|_select | Edit Foint 1l
DS H S =K - O EEN
Sewing Order 2% 0N FEEEEN i
) [ g AEEE AN
- b HENEEENEEEN)
ge | G| & [ ] ]
h Colors Used e
- ‘
Show Colar Palette —I e

o Thread brand name or name of user
thread chart and its thread color list:
Displays the brand name and its thread
color chart for the currently selected
pattern.

e Colors Used
Displays all thread colors being used in
the embroidery design.

9 Show Color Palette
Click to display the [Color] pane.
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M Color pane
Palette mode

Colar o X
itlimport |E color| {illf Sewing At... ABText Attrib...
o .
= (" Region
@ ——ThesdChat [BROTHER EMBROIDERY  ~|
500
i EMEROIDERY
BLACK

EEEECHENE
EEECOECCO
EEEOCEEN
HEECOHN
A EEEEN.

O A
o— To ligt mode I
List mode
Color 3 X
it limport Color | il sewing At.. AB Text Attrib...
Q—4» = g
& Line  Region
@© ——TheadChat [EROTHER EMBROIDERY  ~ |
900
i EMBROIDERY
BLACK
| Calar | Code | Brand | Descriptic »
1 JEEM 900 EMBROIDERY  BLACK
2 001 EMBROIDERY WHITE
©— M0 EMEROIDERY  RED
4 085  EMBROIDERY  PINK
5 [ 035  EMBROIDERY  DEEFPFRC
3 124 EMBROIDERY FLESHP
7 M 107 EMBROIDERY  DARK FL
5 BN 030 EMBROIDERY VERMILL,
£ >
</ ||| @




Specifying Thread Colors and Sew Types for Lines and Regions

o Select the type of stitching ([Line] or
[Region]) to display the corresponding
colors being used.

Line
Line color
Region
Region color

e From the [Thread Chart] selector, select
a thread brand or your user thread chart.

9 From the list of thread colors, select the
desired color.

e Click to switch the mode.

@ Displays all thread colors being used in
the embroidery design. When an
embroidery pattern is selected, a frame
appears around the colors used in that
pattern. The same thread colors can be
specified by selecting them here.

M Special colors

L | D N N | O e e
IEECUTT T T RN
ME ga? DT

I T e

LL |

)

@ NOT DEFINED
If you want to be able to manually select
the color for a monochrome pattern, you
can select [NOT DEFINED].

Colors for creating appliqués:
You can create appliqués using the
following three special colors.

APPLIQUE MATERIAL
marks the outline of the region to cut from
the appliqué material.

APPLIQUE POSITION

marks the position on the backing
material where the appliqué must be
sewn.

APPLIQUE
sews the appliqué on the backing
material.

M

By using the Applique Wizard, appliqués can
easily be created.

»» "Creating appliqués” on page 29
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Setting the sew type

The [Sew] group in the [Shapes] tab allows you to
set the sew type.

: \. Untitled - PE-DESIGN PLUS2 | | Shape:
)‘ Home Image Wiew Shapes
" Edlit Pe -
Y v Zigzag Stitch

Delete Foint

Setea

| FIEEEREED R stiten

Sewr

Setect Edit Point

®

@ Line sew type selector
® Region sew type selector

B Line sew types

Zigzag Stiteh E |||
(1] FFreeasy Not Sewn (Line) Page
s Zigzag Stitch —-»» 106
————— Running Stitch —p» 106
SESR-SE Motif Stitch —»» 106

The sew type for lines in shapes and text can be
selected in the [Line sew type] selector.

Click the [Line sew type] selector, and then select
the desired sew type.

@ Not Sewn (Line)
Select this setting to turn off line sewing
(line will not be sewn).



Specifying Thread Colors and Sew Types for Lines and Regions

W Region sew types Specifying sewing

Fill Stitch - Cr .
3 A stite Bl Page attributes
0 E] Mot Sewn [Region)
MM satin Stiteh » 107 1  Select an embroidery pattern, a Shapes tool
i18831H8 Rl stiten » 107 or a Text tool.
HIEHIH Prog. Fil stitch——————— > 107 2  Click the [Sewing Attributes] tab.
BR52 52 Motif Stitch » 108 — -
W Stippling Stitch ———— » 108 i |impart B Color $% Sewing At A8 Tert bbb,
7 Line sew
[ Undes sewing
The sew type for regions in shapes, and text can be o wan | B =
selected in the [Region sew type] selector. e to il 3

¥ Undes sewing

Click the [Region sew type] selector, and then i P o| o

select the desired sew type.

Drinesction

— The available region sew types differ i _—
depending on whether a shape pattern or h SD AL
text pattern is selected. P snion P Zimm B
o Not Sewn (Region) B
Select this setting to turn off region U“"m i
sewing (region will not be sewn). | i | i 1
A °

»» "Specifying sewing attributes" on
page 63 and "Region sewing

attributes" on page 107 @ Hint view

With each change in the settings, a
preview of the stitching can be checked
here. By moving the pointer over each
setting, a preview of the setting can be
displayed.

e Click this button to return the attribute to
its default setting.

M

The sewing attributes displayed in the dialog box
depend on the selected sew type.

3  Change the sewing attributes displayed under
[Line sew] or [Region sew].

— The settings are applied to the embroidery

pattern each time the settings are changed.

»» For details on the different sewing
attributes and settings, refer to "Line
sewing attributes” on page 106 and
"Region sewing attributes" on page 107.
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Creating Embroidery Patterns

Containing Text

Tutorial 6: Combining Text

This section will describe how to import and edit two text patterns, then combine them to create an embroidery

sEAY,

design.

10

The sampile file for this tutorial is located at:

Documents (My documents)\PE-DESIGN PLUS2\Tutorial\Tutorial_6

Step 1 Entering text
Step 2 Changing text color and sew type
Step 3 Importing transformed text

Step 1 Entering text

1 In the [Import] pane, select [Text] from the
[From] selector, then [Serif Fonts] from the
[Category] selector.

Select [TN_001.pes] (Serif 01), and then click
[Import].

Import ax

filmnar B catnr i couinn r AR Towr attrin

From Teat -

Cotzgany Senf Fonkz -

TEXT (JEJT TEXT

TN_DOlpes | TH_ODdpes  TH_ODGpes

THEXT TBXY

TH_MZpes  TH_M@3pes

64

2 Clickthe [Text Attributes] tab, click in the text
field to enter input mode, delete the text

"TEXT", type in "10", and then press the
<Enter> key.

Text Attributes o x
£ import I Color HiliSewing At... AB Text Attrib...
Show List |

3 Select the text "10", and then click the [Text]
ribbon tab.



Tutorial 6: Combining Text

Click the down arrow to the right of the [Text
Size] selector in the [Font] group, and then
select "30.0" from the list.

Untitled - PE-DESIGN PLUS2 _ Teat

@)
e Inage  Wiew | Test
k A 001 ABC Sef 01 (1w -} = || ||| ez ot Sewn wine
-S-a!s_a Tas _ |- | AAAMAA satin stech
saisct || inpus ||| 52 = | =
g

Sewing O

B & )
Bm G| b |2
e —

Step 2 Changing text color and
sew type

Specify a color and sew type for each shape
as follows.

Line sew

» Line sew type : Zigzag Stitch
* Line color : ULTRAMARINE
Region sew

* Region sew type : Satin Stitch
* Region color : RED

65

Step 3 Importing transformed

2

text

In the [Import] pane, select [Transformed]
from the [Category] selector.

Select [TT_001.pes] (arched text), click
[Import], and then move the imported text

above the “10”.

Impart

i mport | Bl color  #% sewing At AB Text Attrib...

From

o x

Teat -

| Cobzgany

Tianzlormed - |

&8,

TT_001.pez

Pgx" Tt

TT_D0Zper  TT_O7pes

Ty

TT_MET pez

TEXT

TT_025 pes

Click the [Text Attributes] tab, click in the text
field to enter input mode, retype in "TEAM"
and then press the <Enter> key.

TEAM

% Trarsfors

Select the text "TEAM", and then click the

[Color] tab. Select [ULTRAMARINE] as the
region color.

Select the text "TEAM" with the [Select] tool,
hold down the <Shift> key, and then drag a
black dot in a corner of the pattern to enlarge
the pattern to the desired size.




Tutorial 6: Combining Text

5 Drag ) to adjust the radius of the circle that
the text is formed on.

Drag the text to adjust its position.

L "‘.mtg' |
e -\“ i .
.'{ - ot~ ¥ “\*\
u
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Advanced Operations for Entering Text

Advanced Operations for Entering Text

Entering text
1  Click the [Home] tab.
2 Click [Text] in the [Tools] group, and then

click | A .

*
Home Image View

i = s —
k o Cut L5 Duplicate i a‘ C |Q Q
N || Ly copy 2= Arrange Copy = | | i q:p
Shapes |
E';"_i Paste [ Delete - - HN:" %!
Cliphoard TextTools pols
iA ABCL
Sewing Order TR 20

¥

Untitled - PE-DESIGN PLUS2 | Test

X &y
Home Image View | Test
A ot ABC S 01 (10em-) = || =] s mint e ey -
elect | S| 10p - || AWM Satin Skt -

inpur || Fomt sew

3 If necessary, change the font, text size, color
and sew type.

»» "Setting text attributes" on page 68 and
"Embroidery attributes for text" on
page 70

Click in the Design Page.

[ Text Abtribtes 3 x
* iilimport B Color S Sewing At | AB Ted Attrib,.,

Show List

5 Type the text.

150 |, Textattributes 7 x

* Cdimport Bl Color [fSewing At ABTest Attrib.,

’ABC

Shaw Lt |

67

M

» Characters can also be entered by clicking them
in the character table. To display it, click [Show
List] under the text field. This is particularly
useful if you have to enter accented characters
that are not available on your keyboard. To hide
the character table, click [Hide List].

P | Tensmibues

* i lmpot Elcoinr Bisewng st At s,

C

INEAECENNEERERNE
K] EIRCAKIIE <[ =[=[7]
FREFENEEEERN
HFLE AL ZI T
- MARGIERR
| L I i N

» Hold down the <Ctrl> key and press the
<Enter> key to enter a new line of text.

6  Press the <Enter> key or click the Design

Page.
Sewing Order LR N . , [
EEE N By -
Ba) Ga ) X "A I
1 ABC
A ]
2
B
3 o
C

a

If the entered character is not available with the
selected font or if the character cannot be
converted to an embroidery pattern, the character
appears as D in the Design Page. If this occurs,
enter a different character.




Advanced Operations for Entering Text

Editing entered text

Switch to one of the following text edit modes, and
then type text as needed using the cursor appearing
at the end of the text.

B Using Text Attributes tab

1 Select a single text pattern.

2 Click the [Text Attributes] tab, and then click

in the text field.

Text Attributes oo

£ import I Color il sewing At..| AB Text Attrib...

‘ABC| \

HideListl
BENNEBEPENNEERENNE
[o[1]2[3l4[5l6] 789 [ I<[=[=]7
|@[A[BICIDIE[FIGIHITTIKILIMNOI

B Using keyboard

1  Select a single text pattern.

2

Press a character key in the keyboard.

M Using Text tool

1 Click [Text] in the [Tools] group of the
[Home] tab, and then select | A .

=N
2
b Home Image View
\ X cut B3 Duplicate A Cﬁ\ (& &
il 13 Capy 3= Arrangs Copy ™ A
Select!||| .. = Text | Shapes |.{""" Lol
= [E[y Paste [T Delete ¥ - )
Selact Cliphoard TextTools  pals
NEEREr R A sec
: = 0
Sewing Order X m o ——l

2 Click a text pattern to edit.
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Setting text attributes

Text attributes can be specified with the [Font]
selector and [Text Size] selector in the [Text] tab.

Untitled - PE-DESIGH PLUSY Test

P
%

seiect

Home
|

A

Text

Input Font Saw

Image Wiew Test

w01 ABQ Sedi0l (10mm-)

= || | Bl | Ferveces Mok Sewn fLine)

| AV Satin Stitcy

100

M

The [Text] tab appears when a text pattern or a
Text tool is selected.

M Font

Click the [Font] selector, and then select the
desired font.

006 ©

[ | |
I E"ABC”_%M 01 (10mm -)
o1 ABC Serf 01 (10mm -}
009 ARG Gothic 02 (10mm -)

001 ABC Serf 01 (10mm -}
002 m Serpt 01 (10mm -}

o Font Type
A number identifies built-in fonts.

e Font sample
If a single string of text is selected, the
fonts in the list appear with the selected
characters.

9 Font name
9 Most recently used fonts

M Text size

Click the [Text Size] selector. Type the desired
height and press the <Enter> key, or select the
desired value.

Built-in fonts are listed in the [Font] selector with the
recommended minimum size. We recommend
using these fonts at a size equal or greater than the
size indicated.

=

5.0

[001 ABC Sef 01| (10mm-) | |~
|
@

@® Recommended minimum size



Advanced Operations for Entering Text

M Specifying various text attributes
1  Select the text.

2  Click the [Text Attributes] tab.

I8 |, Tedtamibutes n =
A &)import H Color Msmwul. ﬂ.E'rm;.ﬂrih...-l
‘ABC

Show izt |

Character

"
Spacing: IIE _l (i |@|

I Trensfom

If the [Text Attributes] pane is not displayed,
click the [View] tab, then [Attributes], and
then click [Text Attributes].

3 Change the text attributes.

Text Attributes o x
£ import I Color HiliSewing At... AB Text Attrib...
Show List |
(1) Charac =
— aracter 0.0 0
Spacing: | 1

©—
ABC AsC [ABT

o Character Spacing

2.0 mm

ABC

0.0 mm

ABC

e Transform
Refer to the following section.

M Transforming text

ABCDE ®p AncpE

1 Select the text.

2  Selectthe [Transform] check box, and then
click the transformation shape button.

<

Character o0
Spacing:

ABC ASC pBG

Depending on the selected shape, a dotted
line and ‘ appear around the text.

ABCDE ™ ianens

a

A text pattern contains data for both line and
region sewing. Therefore, if this command is
selected, depending on the form of the font, there
may be a gap between the line and the region in
the text.

3 Drag ‘ to transform the text.

aniod W ABCDE

M

. ‘ can only be dragged vertically.

* To return the transformed text to its original
shape, clear the [Transform] check box.

Amend WP ABCDE
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Advanced Operations for Entering Text

If was selected in step 2, the following
operations can also be performed.

Drag ‘ “ and ‘ to transform the text.

‘ :Adjusts the text size.

Ld

’ :Adjusts the radius of the circle.

*
n [

70

Embroidery attributes for
text

The Sew group in the Attributes tab allows you to set
the embroidery attributes (thread color and sew
type, outline and inside region on/off).

When text is selected, settings can be specified for
the following.

PLUS2 Text.

view || Text

WG Serif 01 (10mm -}

Fant I Saul

- f----- Aunning Stitch g
|- || AAAAA - satin stiten v
|

o Line color/Region color
Sets the thread color for outlines and
inside regions.

»» "Color" on page 61

Line sew type

Sets the sew type for the outlines.
Except with built-in fonts 025 and 029, all
sew types are available for lines in text.

»» "Line sew types" on page 62

Region sew type

Sets the sew type for an inside region.
[Satin Stitch], [Fill Stitch] and [Prog.
Fill Stitch] are available for lines in text.

»»  "Region sew types" on page 63

a

» Text patterns created using built-in fonts 025
and 029 have an inside region. The thread color
and sew type for only the region can be
selected.

» Sewing attribute that can be set with Text under
sewing. For details, refer to "Region sewing
attributes"” on page 107.




Advanced Operations for Entering Text

M

» Toturn off line sewing, select [Not Sewn (Line)]
from the [Line sew type] selector.

» To turn off region sewing, select [Not Sewn
(Region)] from the [Region sew type] selector.
» The variety of embroidering effects possible

differs depending on the selected combination of
settings for line sewing and region sewing.

Line sewing Region sewing
specified specified

(Text Outline Sew (Text Body Sew
Type) Type)

Any other than [Not
Sewn (Line)]

Any other than [Not
Sewn (Region)]

=

Any other than [Not

[Not Sewn (Line)] Sewn (Region)]

=

Any other than [Not
Sewn (Line)]

[Not Sewn
(Region)]

=

Small Text
(! §

Precautions for embroidering small text patterns.

»» "When sewing small fonts" on page 72

M Entering small text
1  Click the [Home] tab.

2 Click [Text] in the [Tools] group, and then

click |ase .

Image Wiew

= Duplicate
i= Arange Copy ~ ‘

=
?P—’J Home
o Cut

M

| Salect ||

A

Text

%
oa shapes

G
Faste (] Delete [

Clipooard

DS HSER =

Sewing Crder Wose o, o

{| Text Tocls ols

A

ABC

3  Entertext in the same way that regular text is
entered, starting with step 3.

»»  "Entering text" on page 67

71

M

Sample small text font patterns are available in the
[Import] pane when [Text] is selected in the
[From] selector and [Small Text] is selected in the
[Category] selector.

»» "Example of Importing Embroidery Data" on

page 13

M Editing small text

Small text attributes can be selected from the [Text]
tab, the [Text Attributes] pane and the [Color]
pane. When the small text tool is selected, the
[Text] tab appears as shown below.

PE-DESIGM PLUS2 Test.

Image  Wiew | Test

5,01 ABC LiahBod 5 F&mm) - M-
50

Font Sew

M

The [Text] tab appears when a small text pattern
or the small text tool is selected.

Small text fonts

5,01 ABC Utsh Bold 5 (5-6mm) [« ||[I -

5,01 gﬁ{: Utah Bold § (56 mm)
5,02 Qg{: Belgum 5 (56 mm)
&,DS ﬂﬁg Calgary Mediumltalic S5 (56 mm)

Utah SR (3-4 mm)
D5 |C.a|gar).r Mediumitalic SR"{EH mm}l

i
9 4]

o Font number

e Font sample

9 Font name

9 Recommended size

»»  "“Font List" on page 110

a

Only built-in fonts specifically for small text can be
used.

»» For a list of the built-in fonts specifically for
small text, refer to "Small Text" on page 111.




Advanced Operations for Entering Text

The settings for all small text attributes except the
font are specified in the same way that they are
specified for regular text patterns.

However, with small text, settings cannot be
specified for the following.

e Sew type
* Sewing Attributes
e Transform

M

To edit an entered small text, select the small text
with the [Select] tool, and then type the new text
into the text field in the [Text Attributes]
pane.There are other ways to edit text.

»» "Editing entered text" on page 68

B When sewing small fonts

For best results when using your embroidery
machine to embroider patterns containing small font
patterns, follow the recommendations described
below.

1 Reduce the thread tension to less than what is
used when embroidering normal designs.

2 Sewata speed slower than what is used when
embroidering normal designs.
(For details on adjusting the thread tension
and sewing speed, refer to the Operation
Manual provided with your embroidery
machine.)

3 Do not trim the jump stitches between the
characters.
(For details on setting the machine for thread
trimming, refer to the Operation Manual for the
embroidery machine.)
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Creating Embroidery Patterns Using

Images

Tutorial 7-1: Auto Punch

In this section, we are going to use the Auto Punch function to automatically create an embroidery pattern from

an image.
Step 1 Importing image data into PE-DESIGN PLUS2
Step 2 Starting the Auto Punch wizard
Step 3 Applying an image mask and adjusting its size and position
Step 4 Creating a border from the mask outline and converting to an embroidery pattern

Step 1 Importing image data into
PE-DESIGN PLUS2

[ I oy I Ll B o i i
1  Click the [Image] tab. e [
2 Click [Open] in the [Image] group, and then .
click [from File]. e
G Unt
t’?./ Home Image Wiew 4 |
g Save 7 [y Rotale Right f;'- . . 'H . e i ...,,.-
IEO@. L Modify image || | Rotate Left § @ P‘;? ——— — =
Sl —8— @ | Hoee Punch Stitch - sttch 1- 11101 e
| osen imane 1 Edit | Stiteh Wizard
] from File.., s m
ﬂﬁ fram Clipnoard. .. ke ] (50 : : ; ;

» Images with few and distinct colors work best

3  Double-click the [Documents (My with [Auto Punch].

documents)\PE-DESIGN PLUS2\Tutorial\ + Repeat steps 1 to 4 to choose another picture
Tutorial_7] folder to open it. image. Otherwise, the image can be replaced
- with the [Select Mask] dialog box.
4 Select the file [penguin.bmp], and then click »» "Select Mask dlalog box" on page 87

[Open], or double-click the file's icon. ) ) i )
* You can import picture images from clipboard,

Dpen i image fie B

P 3 rmsm and import that image.
K _ el »» "Importing and Editing Image Data" on
Y
¢ Step 2 Starting the Auto Punch
- ’ wizard

Fioe ol rpac e FaeT b ™11 g~ prg -7t - Tavs 1

Click the [Image] tab.

— The image appears in the work area. ) ) . .
2 Click [Auto Punch] in the [Stitch Wizard]

group.

Untitied - PE-T

“]
B
;,PJ) Home Image View

F%,J [y 5eve - [y Ratate Right ® @ ('a -:__§
Op_en E AL (— et Aute JCrosz ;:Zt: P:o‘o
= e I o ) ¥ t
- = Ve | (5 perere Punich |titch - Stiteh 1~ Stitch 2
Image Edit Stitch Wizard
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Tutorial 7-1: Auto Punch

Step 3 Applying an image mask Step 4 Creating a border from the
and adjusting its size and mask outline and
position converting to an

embroidery pattern
1 Click m to select the circle mask.
Drag handle to adjust the size of the mask,
and drag the mask to adjust its position.

Select the [Add mask outline] check box, check
the preview image, and then click [Finish].

Click [Next. | o - T I
S = —
= :\ -
(& - :
< :
-: Crwaie Linen.
.»rm—-dcm| Fen e 3]
________________ J, "“'"““"_hz— — : R
- AN, o] o | [ ]
= O J—
= '
»»  "Select Mask dialog box" on page 87.
The mask outline selected here can be used as :s e e W
line data (border) in "Step 4 Creating a border from (1] :
the mask outline and converting to an embroidery . T
pattern” on page 74. }_ _
L
2 Drag the image to adjust its output location ! = —
and size. The white background indicates the | — LT
sewing area in the Design Page. bt e 1ot e

Click [Next].

Check Mask Shape/Modify Image

— The image is automatically hidden and
stitches are automatically input.

723481 3mm

»»  "Check Mask Shape/Modify Image dialog
box" on page 88
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Tutorial 7-1: Auto Punch

Auto Punch Parameters

di

alog box

[T —

DuitFlagos O Lina Loy
Cokur

==

| = o

yo

e— I Febiraa aiiee 'a';l‘»z‘;mmnnmr =] e
e_ P echation e w0 0 v v e s e u._:..-gun_:—e
s ] |

©
o Result View

M

The resulting analyzed image appears in
the Result View box.

e Omit Region Colors/Omit Line Colors
In the [Omit Region Colors] list and
[Omit Line Colors] list, click the colors to
select whether or not they will be sewn.
You can select whether or not areas will
be sewn by selecting their colors. Colors
that are crossed out are set to not be
sewn.

9 Zoom

9 Create Lines
Click this button to display the [Select
Regions] dialog box, where the areas to
be converted to lines can be selected.

Select Regions

Click the areas to be converted to lines,
and then click [OK].

[T —

DuitFlagios O Lia ooy

=

s

|

-5

Thasacl

[BAITHER ENERDERT -

+ Hgh M Huberd G
F=

[ Aekdrasck ot

M eikation Lw @

tl

L L T iy
il

< P ol Frsh

* To select whether or not a part of the image is to ©® Thread Chart

be sewn, click in the Result View box, or click in
the [Omit Region Colors] and [Omit Line
Colors] lists.

Areas filled with a crosshatch pattern in the
Result View box will not be sewn.

In addition, lines that appear as dotted lines will
not be sewn.

@ These areas will not be sewn.
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Select the thread chart to be used.

@ Add mask outline
If this check box is selected, line data is
created from the mask outline.

0 Noise reduction
Sets the level of noise (distortions) that is
removed from the imported image.

@ Segmentation sensitivity
Sets the sensitivity for the image analysis.

@ Max. Number of Colors
Sets the number of colors used.

@ Retry
To view the results of the changes, click
this button.



Tutorial 7-2: Cross Stitch

Tutorial 7-2: Cross Stitch

Cross Stitch embroidery patterns can be created from images.

Step 1

Importing image data into PE-DESIGN PLUS2

Step 2 Starting the Cross Stitch wizard

Step 1 Importing image data into
PE-DESIGN PLUS2

Importing image data.

Select the [Tutorial_7] folder, and then select
[tulip.bmp] as the image.

For details on importing image data, refer to
"Importing image data into PE-DESIGN PLUS2" on
page 73.

Step 2 Starting the Cross Stitch
wizard

1  Click the [Image] tab.

2  Click [Cross Stitch] in the [Stitch Wizard]
group, and then click [Color].

) Urtitled - PE-[
=3

e Home Image Wiew

E['g‘ [Ty Seve [y Retate Right @ @ ﬂa r—_‘-%

[Bk Modify image || ¢ Rotate Left I
Open — e o Auto ||"Crass || Fhote  Photo
— ! L] E Delete Punch) |Stitch = fititch 1= Stitch 2 -
_ Image | Edit Lo Sk
MEBRSEE s Color
Sewing Order B oy L ; Sepia |
T TR g ray 5

[T 5 |'._5 | L Gray ce——

3  Click [Next].

< .
O

- .

[ 1
. i~
| o Tominege. |

From this dialog box, an image mask can be
applied, and its size can be adjusted and
shape edited. For this example, we will simply
continue to the next step.

»» "Select Mask dialog box" on page 87
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4  Click [Next].

Check Mask Shape/Modify Image

Fito page

991931 mn

From this dialog box, the size and position of
the image can be adjusted. For this example,
we will simply continue to the next step.

»» "Check Mask Shape/Modify Image dialog
box" on page 88

Click [Next].

Cram Sttch Pararesten

G
T

Trrmad Chas-
§AIOTHER EWBFOIDER =

| o | []

In this dialog box, the cross size and the
number of colors can be specified. For this
example, we will use the default settings.



Tutorial 7-2: Cross Stitch

6  Click [Finish].

Bt vz Stiech

-
B
Lok pien
5::“
EADDERT
Dugeiobn. ||

Caz Sich Tormz:
[anpe =]
Bk Trme
o]

T Divgtay Tanplede

I tektrasek: mitea

o) [C]

In this dialog box, stitches can be added,
deleted or edited, and colors and the number
of times each stitch is sewn can be specified.
For this example, we will use the default
settings.

< P

" IR TRk

1O e i el

— The image is automatically hidden and
stitches are automatically input.

Cross Stitch Parameters
dialog box
=)

Crom Stich Parsraten I
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1
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Moo Gk e e
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7

o Result View
Areas that will not be converted to
cross-stitching are shown with a
crosshatch pattern.

e Omit Colors

In the Omit Colors list, click the colors to
select whether or not they will be sewn.

M

» To select whether or not a part of the image is to
be sewn, click in the Result View box, or click in
the [Omit Colors] list.

 Areas filled with a crosshatch pattern in the
Result View box will not be sewn.

@ These areas will not be sewn.

9 Zoom

e Cross size
Sets the size of the pattern.

©® Thread Chart
You can select the brand of thread to use
in the created cross stitch pattern.

@ Max. Number of Colors
Sets the number of colors used in the
created pattern.

0 Retry
To view the results of the changes, click
this button.

@ Next
Continues to the next step ([Edit Cross
Stitch] dialog box).



Tutorial 7-2: Cross Stitch

M Edit Cross Stitch dialog box O zoom
Click a button in (1) to select the type of stitch, @ Display Template
select a thread color in (2), and then click or To display the imported image, click
drag in (3) to edit the stitches. [Display Template].
00 ©® Add mask outline
| i If this check box is selected, line data is
|@ & created from the mask outline.
N @ Cross Stitch Times/Backstitch Times
: For the number of times each stitch is to
be sewn, select [Single], [Double] or
i [Triple].
Eﬂn:ﬁr | e &
Dhargelobn ||
Mmemie | If [Previous] is clicked to return to the [Cross
ST o 7 Stitch Parameters] dialog box after the stitches
O— o —— o have been edited, the edited stitches are reset to
cove|  _oew ] . their previous arrangement.

o Selecting stitches
Selecting stitches to be added/deleted

& (cross-stitches): Specifies a
cross-stitch inside a box.

(backstitches): Specifies a back stitch
inside ( [~ or || ) oron the edge (| |

or | ) of a box.

e Color Option
To change the color, click [Change
Color] to display the [Thread Color]
dialog box, and then click the desired
color.
To select the color to be used for a stitch,

click Vi , and then click the stitch to
be sewn with that color.

9 Editing area

+ For cross-stitches
Clicking a box: Adds one stitch.

+ For backstitches
Clicking an edge of a box: Adds one
stitch at the edge.
Clicking a diagonal line in a box: Adds
one stitch on the diagonal.

¢ For both cross-stitches and
backstitches
Dragging the pointer: Adds
consecutive stitches.
Right-clicking/dragging with the right
mouse button held down: Deletes one
stitch/deletes consecutive stitches.
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Tutorial 7-3: Photo Stitch 1

By using the Photo Stitch 1 function, embroidery patterns can be created from photos. This type of embroidery
pattern created from a photo has detailed and overlapping stitching.

Step 1 Importing photo data into PE-DESIGN PLUS2
Step 2 Starting the Photo Stitch 1 wizard
Step 3 Applying an image mask and adjusting its size and position
Step 4 Selecting appropriate thread colors and creating an embroidery pattern
Step 1 Importing photo data into Step 3 Applying an image mask
PE-DESIGN PLUS2 and adjusting its size and
Importing image data. position
Select the [Tutorial_7] folder, and then select 1 Drag the handles to adjust the shape of the
[swimming_girl.jpg] as the image. mask. Drag the mask to adjust its position.
For details on importing image data, refer to R
"Importing image data into PE-DESIGN PLUS2" on i N A
page 73. Q =
Step 2 Starting the Photo Stitch 1 (j[
wizard j
1 Click the [Image] tab. L
A ::'
2 Click [Photo Stitch 1] in the [Stitch Wizard] ___J s
group, and then click [Color]. =] oo |
gl | e |

Untitfed - PE-D

'_P_y Home | Image | Wiew

1 [y Sawee - || D Rotake Right @ @ f_§ —3
[B Moalty image || | Rotate Lent aal | aS
Open -~ a— Y - #uto  Cross || Phota Fhoto
- ol i ekl (| 8] Detete Punch Stitch <[ Stiteh 1] Stiten 2=
ot

2  Then click [Next].

Click [Design Settings].

i e Sl

MEHGEE P I T e —

» With [Photo Stitch 1], an embroidery pattern
can be created in color (Color), sepia (Sepia),
grayscale (Gray) or one color (Mono). For this S
example, select [Color].

« Creating beautiful photo embroidery B ] e | (ER]
- The following types of photos are not
appropriate for creating embroidery patterns.
+ Photos where the subject is small, such as
in photos of gatherings
+ Photos where the subject appears dark,
such as photos taken in a room or taken
with backlighting
- Animage with a width and height between 300
and 500 dots is suitable.
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Tutorial 7-3: Photo Stitch 1

4  Select [Hoop Size] and choose a Design

Page size of 100 x 100 mm from the selector. Step 4 Selectmg approPrlate )
Then, click [OK]. thread colors and creating
pom— an embroidery pattern

il

o | Defast | Cancel |

5 Qlick [Fit to page] to change the final finishing At this point, the embroidery pattern can be
size.

completed by clicking [Finish]. However, this
section will describe how to improve the photo
stitching by changing various settings.

Ok ik Shop Ml g

1 From the [Thread Chart] selector, select
[Brother Chart (Photo Stitch)].
In the [Max. Number of Colors] selector,
specify "20".
Click [Update Preview].

Photo 5titch 1 Parameters.

Thiead Charl: Brother ChertfPhoto 5 lkch] 'I
¥ Pl Felect e Nurben of Cokors: [0 5]

e s | ot | e | [ Re.[ Co... | Code | Brand Descrgtion A | ; =
b . e - . Ay o {
2w o7 ightble = ‘
» "Check Mask Shape/Modify Image dialog b o bnelet) :
box" on page 88 and "Gray Balance /
Modify Image dialog box" on page 89 2  Slide the [Brightness] slider one position to
the left, and the [Contrast] slider two
m positions to the right.

Click [Update Preview].
» The size of the embroidery pattern appears in

the lower left corner of the dialog box. The user R ||

can change the size freely with this display. el R e e
« The minimum sizes of embroidery patterns that munfch. B9 S | g g >

can be sewn are listed below. % SowPogs Cob et o Contidates.

¢ Face only: 100 x 100 mm s

+ Head and face: 130 x 180 mm [I]

Make adjustments as needed, depending on the
image. If it is difficult to adjust the tone, click
6  Check the preview of the area to be converted [Select from Candidates].

then click [Next]. »» "Select from Candidates" on page 82.
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Tutorial 7-3: Photo Stitch 1

While looking at the preview on the right side,
select colors from the list for the most
frequently used colors (light blue for the
background) and for the more characteristic
colors (deep rose for the lips), and then click
[Reserve].
— For this example, four colors (cream brown,
light blue, salmon pink and deep rose) are
reserved.

| Ae..| Co..| Code | Brand Domrphen &
UL F:iK oy

2 ¥ [l cimam biown

T % fiikg iaft hise

- alz cream pedion

5 ¥ 074 selmor i

5k 389 B gy

el g 642

ook N 13 fghk shading 1.,

il . Rl umpkin

UL Rk e gis=n

A1 4 . 0lG dees e -
w2+ . 337 1edizh broww
< i >

Add. I Aamawe o

In the [Max. Number of Colors] selector,
specify "10", and then click [Update Preview].

Photo Stitch 1 Parameters

Thiead Chart.  [Brother (rmstmna o 1
¥ duto Select | Max, Hurber of Colors: |17 _|:j|
[Re...| Co..| Code | Brand | Description |
e i} cream brown
2 X n7 light blue g
w3 ® 073 salmon pirk A

Click [Finish].

Fhotn soech | Faraetery

Thesd Chat Buore OreaProcciniol) =]
] Ha Wit Cote 110 2
[ T To Tamshn

i

Zasdanaais

HWioe oW

A et st

— The image is automatically hidden.

M

If the created embroidery pattern contains colors
that you do not wish to emphasize (for example,
grays in the face), change the sewing order in the
[Sewing Order] pane so that the undesirable color
is sewn before all other colors.

»» "Changing colors" on page 38.

Tips for improved results

If the actual thread colors differ from the thread
colors on the screen, the embroidering results will
be greatly affected.

[Brother Chart (Photo Stitch)] is a thread chart
based on the Brother embroidery thread colors and
flesh tones, and has been adjusted to account for
the difference between thread colors on the screen
and actual thread colors; however, colors may
appear differently depending on your operating
environment.

If the thread colors on the screen are different from
the actual thread colors, use the user thread color
lists and adjust the thread colors to achieve better
results.

»» "Editing user thread charts" on page 99

Photo Stitch 1 Parameters
dialog box

With Color, Sepia or Gray
(1]

1
[T — I




Tutorial 7-3: Photo Stitch 1

With Mono
(1]
ﬁ
e
T
a1
Funich [18 =]
Solct fom Concidte.. |
T~ Add mask oul
oo ]
‘ | | cowa qu
e 6 ©0 (5]

Select the thread colors in the color options o
specify the desired settings under [Sewing Option]
9 and [Color Option] 9 and then, click [Update
Preview] Q to preview the effects of the specified
settings. Click [Finish] @ to convert the image to
an embroidery pattern.

o Color options

Color/Sepia/Gray

You can select the brand of thread to

Thread Chart | e in the created pattern.

Select whether thread colors will be
selected automatically (on) or manually

Auto Select (off). Select this check box to turn on
this function.

Number of Sets the number of colors selected by

Colors the Auto Select function.

Displays the thread colors that are
being used. With this list, the thread
colors that are being used can be
checked or changed.

List of colors
used

Click this button to add a thread color to
the list of colors used.

When clicked, the [Add] dialog box
appears.

Add

Select a thread chart, then a thread
color, and then click [OK] to add the
color to the list. Added thread colors will
be reserved as thread colors that must
be used.

82

Remove

Select a thread color in the list of colors
used, and then click this button to delete
the selected color from the list. This is
used to delete unnecessary thread
colors and reduce the number of colors.

Reserve

Specifies thread colors that must be
used. Select a thread color in the list of
colors used, and then click this button to

display 4k in the Reserved column. To
cancel this setting, click to icon so that it

appears as -4 .

Mono

List of colors
used

Displays the thread colors that are
being used.

Change
Color

Click this button to display the [Thread
Color] dialog box, where the thread
colors can be changed.

9 Sewing Option

Selecting a setting closer to [Fine]
creates more details in the pattern and

Detail increases the number of stitches. (The
stitches will be overlapping.)
When the value is lowered, the sewing
Run Pitch pitch (stitch length) will be shortened,
resulting in finer stitching.
Sew Page
Color If this check box is cleared, the parts of
(Available the pattern that are the same color as
only with the Design Page will not be sewn.
Color, Sepia | If it is selected, those parts will be sewn.
and Gray)
Add mask If this check box is selected, line data is
outline created from the mask outline.

e Brightness / Contrast

The top slider is used to adjust the brightness.
The bottom slider is used to adjust the contrast.

Select from
Candidates

The image can be automatically
adjusted.

Click this button to display nine patterns
with different brightness and contrast
levels based on the original image.
Select one of the candidates, and then
click [OK]

A !
@
a

PW@




Tutorial 7-3: Photo Stitch 1

e Update Preview
Update the previewed image after settings have
been changed.

M

« If the [Auto Select] check box is selected, the
thread colors will be automatically selected from
the chart selected in the [Thread Chart]
selector. If thread colors are reserved, they will
included in the colors selected according to the
number specified in the [Number of Colors]
box.

If the [Auto Select] check box is cleared, the
settings in the [Thread Chart] selector and
[Number of Colors] box are not applied, and
only the thread colors in the current list of colors
used will be used to assign thread colors.

* When thread colors are added/deleted, the
[Auto Select] check box is cleared. To use
added thread colors and automatically select
other thread colors, select the [Auto Select]
check box, and then update.

* The thread colors in the list of colors used are
listed, in order, starting from the brightest. This
order is the sewing order and cannot be
changed.
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Tutorial 7-4: Photo Stitch 2

We will create an embroidery pattern with Photo Stitch 2 in a method different than that used with Photo Stitch

1.
Step 1 Importing photo data into PE-DESIGN PLUS2
Step 2 Starting the Photo Stitch 2 wizard
Step 3 Applying an image mask and adjusting its size and position
Step 4 Changing the sewing angle

Step 1 Importing photo data into
PE-DESIGN PLUS2
Importing image data.

Select the [Tutorial_7] folder, and then select
[girl2- face.bmp] as the image.

For details on importing image data, refer to
"Importing image data into PE-DESIGN PLUS2" on
page 73.

Step 2 Starting the Photo Stitch 2
wizard

1  Click the [Image] tab.

2 Click [Photo Stitch 2] in the [Stitch Wizard]

group, and then click [Mono].

=
Home Image View

Untitled - PE-DESIGN PL

[y Sawee - | Ty Aotate Right @ @ p-_a
[ Moanny mage || ¢ Rotate Lem v
Open gy AUty Cross Phato
- g — V|| Foew Punch Stiteh = Stitch 1|9
Imege Edit ) itibehs Wigmol o
CEHERERE = =
Seming et W e 1, : . P '-|
e - L w T z - o |
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Step 3 Applying an image mask
and adjusting its size and
position

7 .
1 Click g to select the circle mask.

Drag handle to adjust the size of the mask,
and drag the mask to adjust its position.

Click [Next].

L
F

jeml

4

:
i

»»  "Select Mask dialog box" on page 87

2

From this dialog box, the size and position of
the image can be adjusted. For this example,
we will simply continue to the next step.

Click [Next].

SR ——

o]
Trn NI I
»> "Check Mask Shape/Modify Image dialog

box" on page 88 and "Gray Balance /
Modify Image dialog box" on page 89




Tutorial 7-4: Photo Stitch 2

Step 4 Changing the sewing Photo Stitch 2 Parameters

angle dialog box

1 Inthe [Direction] box, type "45". With Color

2 Click [Update Preview]. (1] (o]

Photo Stitch 2 Parameters Photo Sm(l 2 Parameters |

a0 ConOp SenraOpion || oo oo
tri — ey Thead Crat

] mm ME ] mm

= [HemODERY = BROTHER EMBROIDERY <]
M. Dens . Densh

= ) 2 Color Set:
[5 =] wemm 5 = e (o]

Change Col.

T [===n == vl s

3 EEET U
[T = dees

™ Add mask outine.

Q

5 =] depee

I~ Add mesk outine.

Biighiness / Contast

Biighiness / Contast

o

Updste Preview

]

<Pioios

<P Cancel

— ©
3 CcClick [Finish].
With Mono

Biighiness / Contast

Sening Opon—— ~Colox Opkon
ez o e
o = L EoERY
= [BLACK
M Densty Photo st 2Parametes
[5 = ietum
| Lz Sewing Opion Clor Opion
Changs Colo, o o
ion [EEe | iz
e = m
M Densty
45 :‘i degree. 145 = line/mm
= Brightness / Contrast =l
S — Change . |
T~ Add mask outine e LO0HEAEE *
o Y o
— [F =] cemee

™ Add mask outine

oo Coreel Frin | | UpdtPisen

<Proion Coce |_r—;m_|

== 3] ©

Specify the desired settings under [Sewing Option]

T U Em e s @ =nd [Color Option] @), and then click [Update

— Preview] 9 to preview the effects of the specified

settings. Click [Finish] 0 to convert the image to
an embroidery pattern.

- = =
T
- Tl A,
| g e g T T T
AL e
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Tutorial 7-4: Photo Stitch 2

o Sewing Option

T »
Line interval %$ Line interval
Lower value Higher value
Max. Density p— e e —yrerye
=
e A S
0° 45° 90°
Direction &ﬁw §§//§§ - ‘%
i — A £
Add mask If this check box is selected, line data is
outline created from the mask outline.

9 Color Option

Color

You can select the brand of thread

Thread Chart available in the [Color Set] selector.

If [Auto Select] is selected, the most
appropriate four colors will automatically
be selected.

Selecting a different option specifies the
four colors used when creating the
embroidery pattern.

The color choices are: cyan (C),
magenta (M), yellow (Y), black (K), red
(R), green (G) and blue (B). Select one
of the following combinations that
contains the colors most used in the
image.

Color combinations: CMYK, RGBK,
CRYK, BMYK

Color Set

Thread

Colors Used Displays the four selected thread colors.

Under [Thread Colors Used], click a
color. Then, click [Change Color] to
display the [Thread Color] dialog box.

gg?o'lge Select the new color and click [OK].
The selected thread color will be applied
to the image shown in the preview
window.

Mono
Click on the [Change Color] button to
open the [Thread Color] dialog box if

Change )

Color you wish to change the color of the
photo stitching. Select the color and
click [OK] to make the color change.

Color/Mono

The top slider is used to adjust the
Brightness / | brightness.

Contrast The bottom slider is used to adjust the
contrast.

Update Updates the previewed image after

Preview settings have been changed.
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Advanced Stitch Wizard Operations

Advanced Stitch Wizard Operations

Image To Stitch Wizard

Click [=2] in the [Quick Access Toolbar] to display
the Startup Wizard, and then click [Auto Punch /
Cross Stitch / Photo Stitch]. If an image has been
imported, the next dialog box appears.

Swwct Stitch Muthod for imege
e e
2 ook
ol (B |- —0
™ PhodaShics 1
1 Mok SR 2
Bizhig .
Thes
Mare:
i
- Hs .o
I B 55— e

o Sample image before being converted

e Sample image of embroidery pattern
after being converted

9 Select the conversion method.
9 Description of conversion method
6 Click to continue to the next step.

M

If no image has been imported into the Design
Page, the [Open an image file] dialog box
appears.

= e meE
-

¥ piiar]
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Adjusting the Mask and
Image
M Select Mask dialog box

The [Select Mask] dialog box appears no matter
which conversion method was selected.

The image will be masked with the
selected shape.

e The mask can be reshaped or
repositioned. Select the tool appropriate
for the operation to be performed.

% | : Drag the handles to enlarge/
reduce the mask. Drag the mask
to adjust its position.

» : Points can be entered, moved and
deleted to create a mask with the
desired shape.

To add points, click the outline of
the mask. To move a point, select
the point, and then drag it. To
delete points, select the point, and
then press the <Delete> key.

a

With a small original image, it may not be possible
to reduce the size of the mask.




Advanced Stitch Wizard Operations

9 If [Auto Generate] was clicked, an outline
of mask was automatically detected from
the image.

The [Auto Generate] button is available

@ Clicking [Open Image] allows you
replace the image with a different one.
The [Open an image file] dialog box
appears. Select a file.

only with images that have a light-colored . )
background, like in this photo. The next step differs depending on the color range

selected for the embroidery pattern.

B Check Mask Shape/Modify Image
dialog box

If Color, Sepia or Gray was selected for [Photo

Stitch 1], [Photo Stitch 2] or [Cross Stitch], or if

[Auto Punch] was selected:

The following dialog box appears.

A mask shape edited with or |
created by clicking [Auto Generate] Q
will be added at the top of the list. Then,

this mask shape can be selected the |

next time a pattern is created using a

Stitch Wizard. A maximum of five 9“;‘:’2

shapes will be added, and they will be 9*;:;’ o e e
arranged in order of the most recently ﬁ -

used. (4]
These mask shapes appear no matter
which Image To Stitch function is ! @ Adjust the position and size of the image.
selected. Drag the image to the desired position.
Drag the handle to adjust the image to the
® zoom desired size.
@ Clicking the [Image Tune] button displays @ Click [Design Settings] to change the
an [Image Tune] dialog box. size of the Design Page. Specify the
— settings in the [Design Settings] dialog
box.

»» "Specifying the Design Page
Settings" on page 32

9 Click [Fit to page] to adjust the image to
the size of the Design Page.

e Embroidery pattern size

Shar
# 4 &
@ § o
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Advanced Stitch Wizard Operations

M Gray Balance / Modify Image
dialog box

If [Mono] was selected for [Photo Stitch 1] or
[Photo Stitch 2]:

The following dialog box appears.

Gray Balance/Modify Image |

00—
&=
00— |
s i | ol |
|

o Adjust the position and size of the image.
Drag the image to the desired position.
Drag the handle to adjust the image to the
desired size.

e Click [Design Settings] to change the
size of the Design Page. Specify the
settings in the [Design Settings] dialog
box.

»»  "Specifying the Design Page
Settings" on page 32

9 Click [Fit to page] to adjust the image to
the size of the Design Page.

e Embroidery pattern size

@ Drag the slider to adjust the gray balance.

89



Importing and Editing Image Data

Importing and Editing Image Data

An imported image can be used with the Image To Stitch Wizard.

a

Only one image can be added to the work area. If you try to display a different image, it will replace the
previous one.

M Image file formats 3 Select the drive, the folder and the file. Click
Images in the following formats can be imported. [Open].
- Windows bitmap (.bmp), Exif (.tif, .jpg), Portable = "”"‘,—_| o
Network Graphics (.png), GIF (.gif) e semiet
an W i e f;.s.P

» Vector image data in the ".wmf" (Windows
Metafile), ".emf" (Enhanced Metafile) and ".svg"
(Scalable Vector Graphics) file formats can be
converted to shape patterns as it is without
some information not supported.

»» "Step 1 Importing vector images (SVG files)"
on page 40

Importing image from a file
1  Click the [Image] tab.

2 Click [Open] in the [Image] group, and then
click [from File].

[y Rotate Right

. Home Image View : = '
T .
TE o e
Auto  Cross  Phota

Bl |3 Mocify image
Cpent| |-, i —
- P —@|d Punch Stitch - Stikch 1-
S 1&. Stiten Wizard
1E] from File... |J;
. . \ .

] rom ceoncns. RS « If the [Preview] check box is selected, the
contents of the selected file will appear in the
[Preview] window.

* Various clip art images can be found in the
[ClipArt] folder at:

(Drive where PE-DESIGN PLUS2 was
installed)\Program Files (x86)\Brother\
PE-DESIGN PLUS2\ClipArt

& | Rotate Left
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Importing and Editing Image Data

Importing image from the Changing the size, angle

clipboard and position of the image
1  Click the [Image] tab. M Selecting an image

2 Click [Open] in the [Image] group, and then 1

Click the [Image] tab.
click [From Clipboard].

— = 2 Click [Modify Image] in the [Image] group.
!{? Home Image View

Py ur
o
@ g Save T o @ @ r-_a _/I Home Image View
; 2
! Madify Images " N e
e |:" — s Auto Cross  Phato @ [ [y Rotate Right @ @ fa
| i PUnCh Stiten = Stiteh | Bk Mogify image || || ¢]Rotate Left L=
[5] [ Stikch Wizard Cpen = - m— Autp  Cross  Phota
T _— - B Wi || ({8 Delete Punch Sitch - Stitch 1+
I 5 | fram File... = Image Edit Stiteh Wizard
[ from Clipooard.. |. | 58 : ] ; —
— = — g 8 -

— The image is selected and appears as
— The image on the clipboard is imported into shown below.
the Design Page.

@

a

This can only be done when there is image data on
the Clipboard.

Adjusting the density of / @
the background image

For detailed instructions, see"Adjusting the density
of the background image" on page 16.

@ Handle
® Redline

M

The status bar shows the dimensions (width and
height) of the image.

M Moving an image
Drag the selected image to the desired location.

M Scaling an image

Drag the handle to adjust the image to the desired
size.
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Importing and Editing Image Data

M Rotating an image
An image can be rotated in 90° increments.

1  Click the [Image] tab.

2 Click [Rotate Right] or [Rotate Left] in the
[Edit] group.
£ '_'_~ 8]
‘{w) Home Image View
o Dgsae - [y rotate migne

D
@ @ 3

Auto Cross Photo
Puneh Stiteh = Stiteh 1

SEkch Wizaig

(8] Modiify image || ¢ Rotate Left

[ Delete
Edit

Rotate Right

Rotate Left

M Deleting an image

1  Click the [Image] tab.
2 Click [Delete] in the [Edit] group.
‘ér.) U
: Heme  Image | View
*‘” §“"‘n o ® *’@ ;3
e Bl

An image can also be deleted by selecting it, then
pressing the <Delete> key.

»»  "Changing the size, angle and position of

the image" on page 91

92

Saving the image data

M Saving as a file

1  Click the [Image] tab.
2 Click [Save] in the [Image] group, and then
click [to File].
';\; (1]
AP
—.) Home Image View
i | [ save | || Dy Rotate mugn: e
@E=1] = @ Q
02 | . tasi.. | Detete ot s s
B o cipboard.. Edlit Stitch Wizaig
3  Selectthe drive, the folder and the format.
Type in file name. Click [Save].
Save an image file x
Sevape ||| PEDESKGH FLUSZ ~| = G efERr
m:m = e e
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m
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M

The image data can be saved in either of the
following formats: Windows bitmap (.bmp), Exif

(-ipg)-

M Outputting to the Clipboard
1

2

Click the [Image] tab.

Click [Save] in the [Image] group, and then
click [to Clipboard].

"f‘!‘) Hame
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Save Image Rotate Left
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Creating Design for Multi-Position

Hoops

Tutorial 8: Creating Design for
Multi-Position Hoops

This program enables you to create multi-position designs that you can stitch in any multi-position hoop
attached to your embroidery machine.

Example of multi-position hoop: 100 x 172 mm hoop

Although the size of the design that can be embroidered using an multi-position hoop is 130 x 180 mm (or 100
x 100 mm, depending on the sewing area of the embroidery machine), first determine which of the three
installation positions (indicated as a, b, and c in the illustration above) the multi-position hoop will be installed
at and determine the orientation of the design.

When creating the design, each design section can only be as large as the sewing area of the embroidery
machine.

The sampile file for this tutorial is located at:
Documents (My documents)\PE-DESIGN PLUS2\Tutorial\Tutorial_8

Step 1 Selecting the Design Page size
Step 2 Creating the design
Step 3 Optimizing hoop changes
Step 4 Checking the pattern
. . 2  Select [Hoop Size] and choose a Design
Step L giezlgctmg iho DeSIgn Page Page size of [*100 x 172 mm] or [*130 x

300 mm] from the selector. For this example,
select [*100 x 172 mm)]. Then, click [OK].

Design Settings

. Untitled - PE-DESIGN PLUS2 T
@ Hoop Size;
]
irw

1 Click s,f_éj, then [Design Settings].

100 172 mm v

Most Recenlly Used Files
I Fotale 90 Degrees

B Gibu
el $09f ‘ ‘ 251y Edit User Hoop.

—

0K | Defaul Cancel
L ]
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Tutorial 8: Creating Design for Multi-Position Hoops

2 Create the design, making sure that it meets
m the following conditions.

+ Settings for multi-position hoops are indicated e g
by " " e a
» Choose the appropriate setting after checking : i
the size of the hoop available for your machine.

Step 2 Creating the design

1 The Design Page appears on the screen as
shown below.

| —a
§ leb |
I J » The size of one pattern must be no larger
than 100 x 100 mm (or 130 x 180 mm).
ec « Each pattern must completely fit within a
] single area (a, b, or c).
* Area T l
- Areaa } <—a
Embroidering area when the multi-position Y T |
hoop is installed at the top installation position. - : |
- Areab - L
Embroidering area when the multi-position ol O 10
hoop is installed at the middle installation T !
position. i <D
- Areac T . J::
Embroidering area when the multi-position . '
hoop is installed at the bottom installation i |
position. e _ -
The dotted lines separate each area. ! !
« If the [Rotate 90 Degrees] check box is ! ! <—C
selected, the embroidering areas appear as T i

shown below.
1: The position of this pattern is correct since it fits
‘ ‘ completely within area a.

| ! 2: The position of this pattern is correct since it fits
! ! completely within either area b or area c.

| 3: The size of this pattern is acceptable, but its

position must be corrected since it does not fit
completely within any of the areas.
‘ (It will be necessary to correct the position in
T T ””””” 1 order to fit in either b or c.)
a b c 4: This pattern must be corrected since it is too
large.
(It will be necessary to correct the position and
size in order to fit in either a, b, or c.)
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Tutorial 8: Creating Design for Multi-Position Hoops

Step 3 Optimizing hoop changes M
1 Click h’;‘j then [Design Settings]. * A check mark appears when this function is
= turned on; no check mark is displayed when this

Untitled - PE-DESIGN PLLIS2 function is turned off.

Most Recertly Used Files

1 CAUSEI. A D00, PEE

| WVizd.

2 Selectthe [Optimize the number of times to
change the hoop’s position] check box, and
then click [OK].

i * When the Optimize hoop change function is
e turned on, the sewing order that you have set is
- optimized to reduce the number of times that the

hoop installation position is changed.

For the example shown on this page, the sewing
order is: a (pattern 1) —» b (pattern 2) > a
(patterns 3 & 5) — ¢ (patterns 4 & 6)

If the Optimize hoop change function is turned
off, each pattern is sewn according to the sewing
order that you have set.

For the example shown on this page, the sewing
order is: a (pattern 1) —» b (pattern 2) - a
(pattern 3) — c (pattern 4) — a (pattern 5) —» ¢
(pattern 6)

Therefore, since the number of times for
changing the hoop installation position is not
optimized, it may be changed more often than if
it was optimized.

a

Since the pattern may not be sewn correctly or the
fabric may not feed evenly if the hoop installation
position is changed too often, we recommend
turning on the [Optimize hoop change] function.
Turning on this function will change the sewing
order that you have set, therefore, check the
sewing order before you begin embroidering.
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Tutorial 8: Creating Design for Multi-Position Hoops

Step 4 Checking the pattern

1 Click ,Pj then [Design Property].

Most Recently Used Files

1 CUsers\..\dog.pes

ME\ Design Seftings...

2

Check the sewing order of each pattern and
the number of times the hoop position will be
changed.

Design Property

o —— About hoop posiion 1/ 3
e ——| < Previous
I Show about selected Object(s)

Untitled
100

File: Name Design Name
File Yersion
Madtied Date -
Width:

Height

Stitch count

Category

100.00 mm
100.00 mm
213

1 min

Authar

—
—
—
—

:

| Basic Colr I

LIME GREEN

Kepwards

Sewing time Comment:
Color changes : 1

Total colors: 1

Calor List @ Colorchangss ' Tatal calors
[ | Color | Code | Brand | Description
| 1 W 513 EMBROIDERY  LIME GREEN

Only the patterns that would be sewn at the
current position in the hoop installation order
appear in the Design Page, and the
embroidering area for the current hoop
position is outlined in red.

o The position in the hoop installation order
for the currently displayed pattern.

e To display information for patterns at
other positions in the hoop installation
order, click [Previous] or [Next].

a

If a pattern is larger than the embroidery area or if
a pattern is positioned so that it does not
completely fit within an embroidery area, the error
message appears. After the pattern causing the
error is displayed, select the pattern and change
its size or position.
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M Saving the design

The design for a multi-position hoop is created by
considering the pattern for each hoop installation
position as one pattern, then combining them.

One multi-position hoop design is saved as a single
file (.pes).

M

« If the file size or the number of color changes is
larger than the specified number, or if one of the
patterns does not completely fit within an
embroidery area, the error message appears.

» The patterns appear on the machine as shown

[ O o

: This pattern is sewn when the hoop is
installed at the top installation position
(position a).

installed at the middle installation
position (position b).

: This pattern is sewn when the hoop is
installed at the bottom installation
position (position c).

H : This pattern is sewn when the hoop is

Therefore, the frame installation position sewing
order for the pattern shown above is b, a, then c.




Tutorial 8: Creating Design for Multi-Position Hoops

Notes on embroidering using the
multi-position hoop

* Before embroidering your design, sew a trial
sample of the design on a scrap piece of fabric
from your design, making sure to use the same
needle and thread.

* Be sure to affix stabilizer material to the back of
the fabric and tightly stretch the fabric within the
hoop. When embroidering on thin or stretch
fabrics, use two layers of stabilizer material. If no
stabilizer material is used, the fabric may become
over-stretched or wrinkled or the embroidery may
not be sewn correctly.

M

 Stabilizer must always be used when
embroidering to stabilize the fabric. There are
many types of stabilizer; the type that you will
use depends on the type of fabric that you are
embroidering on.

» For large-size designs that are split into
sections, the stabilizer must be adhered to the
fabric, for example, iron-on stabilizer. In some
cases, you may need to use two pieces of
stabilizer for your embroidery.

* When using spray adhesive, spray the adhesive
onto a hooped piece of stabilizer that is strong
enough for the entire large-size embroidery. In
some cases, you may need to use two pieces of
stabilizer for your embroidery.

a

» Forbest results, attach the stabilizer to the fabric
(as described on this page). Without the correct
stabilizer, the design may become misaligned
due to puckering in the fabric.

» Be sure to check the recommendations on the
stabilizer package.

* Use the zigzag stitch for sewing the outlines in
order to prevent embroidering outside the
outlines.
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* For patterns that require the hoop to be installed
at different installation positions, design the
embroidery pattern so that the various parts of
the pattern overlap in order to prevent
misalignment while embroidering.

@ Overlap

M Printing a Design Page for a
multi-position hoop

On the first page, a complete image of the Design
Page is printed at actual size. (However, for a 130 x
300 mm Design Page, a reduced image of the
Design Page is printed.) On the following pages, an
image of each design section and its sewing
information are printed in the sewing order.
When [Actual Size] is selected:
An image of the pattern in each design section is
printed on a separate page as the corresponding
sewing information.
When [Reduced Size] is selected:
An image of the pattern in each design section is

printed on the same page as the corresponding
sewing information.

»»  "Printing" on page 47



Supplement

Changing Various Settings

Changing options settings

From the [Options] dialog box, the commands
appearing in the [Quick Access Toolbar] and
settings for the application's appearance can be
selected, and also the settings on shortcut keys,
jump stitches, thread charts can be specified or
changed. Follow the procedure described below to
display the [Options] dialog box.

Click ,Pj and then click [Options] on the bottom of
the window.

Untitied - FE-DE!

|—h Mast Recently Used Files
T

1ChUsers\..\dog.pes

M

The [Options] dialog box can also be displayed
using either of the following methods.

 Click * at the right end of the Quick Access
Toolbar, and then click [More Commands].

* Click [Option] in the upper-right corner of the
window.

B Customizing Quick Access
Toolbar

Home Image View

cut . B[ Duplicate B
k. o A \J’Q
Py Arrange Copy ™
Select ks + Text  Shapes
5 [y Paste [} Delete b +
Select Clipboard Toc
= = B |
Degasr u =| ©)
Sewinn Ardar oo mm 150

@ Quick Access Toolbar

98

1

Click [Customize].

2

o Carcal

Repeat the following operations until the
desired commands are displayed.

o Choose commands from selector
Select a command category.

e Commands list
Select the command to be added.

© Add button
Selected command is added.
The command appears in ®.

Q Remove button
Selected command is removed.
The command is removed from ®.

e -
-
Select an icon in ®), and then click the
buttons at to move it to the desired
position.

@ Reset button
Reverting to the default commands.

Settings for the following can also be specified
from this dialog box.

0 Show Quick Access Toolbar Below the
Ribbon
Select where the Quick Access Toolbar is
displayed. Select the check box to display
the Quick Access Toolbar below the
Ribbon.

After the settings have been specified, click
[OK] to apply them.



Changing Various Settings

B Customizing Shortcut keys

1 Click [Customize] in the command list, then
[Customize] beside [Keyboard shortcuts].
T " =
o =
PR :T':.‘;:::. ([ .
ak:evwsav -
2 .
e ==
=
2  Inthe [Categories] list, select a command
category. Then, in the [Commands] list,
select the command whose shortcut keys are
to be specified.
Customize Keybosrd ®
Catagaris: Cammande:
C:n-:d Heys: Press new shorcut key:
(1) ——rﬁ_ [ -0
Aesigned o:
o st i l————@©
T a—
;:ux:::nimm.
O-
Bemove Feszet A Choae
—
(5]
0
— The default shortcut keys appear in the
[Current Keys] box o
3 Usethe keyboard to record the new shortcut

keys in the [Press new shortcut key] 9 box,
and then click [Assign] e The new shortcut
keys appear in the [Current Keys] box o

— Usage information about the entered key
combination appears. If the key
combination has already been assigned to
another command, the name of that
command appears at e

To remove the default or specified shortcut
keys, select the shortcut keys in o and then
click [Remove] @

To revert to the default settings, click [Reset

Al ©O.
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4

5

Repeat steps 2 and 3 until the desired
shortcut keys have been specified for the
commands, and then click [Close].

Click [OK] in the [Options] dialog box.

Editing user thread charts

1

2

Click [Edit User Thread Chart].

Dptions

Customize T

BROTHER EMEAOIDERY -

| Color | Code | Brend -
1 M 500 EMEROIDERY
2 001 EMBROIDERY
3 M 200 EMEROIDERY

| Edit User Thread Chart

System Unit

DST Settings ‘

Sereen Callaration

A user thread chart can be saved, edited or
deleted.

X
Thread Crart User Thread Char |
mychat =]  nNewcrat
| ] Color | Code | Brand I} ' Rename Chart. --—e
-1 I 001
EMBROIDERY 2 002 Delete Chart --—e
EMBROIDERY 035 | EMBROIDERY | [t
EMBROIDERY 4 M 035 EMBRODERY | impor Chat . detmm
0%  EMBROIDERY —S
EMBROIDERY
EMBROIDERY
EMBROIDERY
EMBROIDERY L5 L"
EMBROIDERY
EMBROIDERY = _ tm  H
EMBROIDERY <Femw o
EMBROIDERY
EMBROIDERY
EMBROIDERY
EMBROIDERY
EMBROIDERY
EMBROIDERY
209 EMBROIDERY
EMBROIDERY :
EMBROIDERY s
EMBROIDERY v 1
> < 5| Edttem .——@
=

o Select an existing thread chart.

e Adds thread colors from a existing thread
chart.

9 When editing or deleting a thread chart,
select the thread chart here before
performing the operation.

e Creates a new thread chart.

9 Changes the thread chart name.

@ Deletes a thread chart.

0 Imports the thread chart.

@ Changes the order of the thread colors.
@ Adds a new thread color.

@ Edits a thread color.

m Displays thread colors in existing thread
chart.

@ Deletes a thread color.

@ Displays thread colors in the user thread
chart.



Changing Various Settings

M Creating a new thread chart
1  Click [New Chart] @.

2 Type in the name of the chart, and then click
[OK].

Mew Thread Chart

K

Cancel

Mame: ||

M

A saved thread chart can be selected from the
[User Thread Chart] selector and [Thread Chart]
selector.

B Renaming a thread chart

1 From the [User Thread Chart] selector €@,
select the chart.

2 Click [Rename Chart] ©.

3 Type in the name of the chart, and then click

[OK].

Rename Thread Chart

M Deleting a chart

1 From the [User Thread Chart] selector €,
select the chart.

2  Click [Delete Chart] @.

3 ifa message appears, click [Yes].

100

M Importing a thread chart
1 Click [Import Chart] @.

2  Selectthe drive, the folder, and the btc, btc2 or

csv file, and then click [Open].

Select Import Chart L4
= o+ mcimE-

Type
File falder

Look n: [ |, PE-DESIGN FLUSZ

Meme

G Serple

E

=
File falder

TSV File

Tutorial

T

g1 [N

g

ie

< 13

Cancel

Fle pene:
Fiea of typa

[rvetantz

&
=

B

Files in the .btc, .btc2 or .csv format can be
imported.

»»  "User thread chart files" on page 101

3

If a message appears, click [Yes].

M Editing a chart

1  From the [User Thread Chart] selector €@,
select the chart.
2  Continue with the appropriate procedure. To

save the changes, click [OK].

B Adding items from a thread chart

1  From the [Thread Chart] selector @, select

the thread brand or a user thread chart.

If multiple user thread charts have been
created, thread colors can be selected from
different user thread charts.

2  From the list @, click the thread colors.

M

To add multiple items, hold down the <Shift> or
<Ctrl> keys while selecting thread colors.

3 Click [Add] ©.

— The selected items are added to the list in
the user thread chart @



Changing Various Settings

M Adding a new item

1  Click [New Item] ©.
2 To create a new color, click [Mix].
Edit Thread
Thread Information ; = =
Color: [ M. | = - |
Code [
Brand:
Description:

3 Specify the color, and then click [OK] to add
the specified color to the [Edit Thread] dialog
box.

Colour x
Basic colours: @ (a)
HMrEAEEENN
ErEEEEEN
EEEEEEE N
ENEEEEEN
EEEEEEEN
EEEEEE N[
Custom colours:
o o
Hug:lﬁ Bed:lﬁ
oo o o e
Disfine Custom Calours >> | ColourSoid 1o Biue-[o55
ok | cancel ‘Add to Custom Colours |

M

The color cannot be changed if the slider (a) is
moved to the top of the scale.

4

If necessary, type in the code, brand and
description into the appropriate boxes.

M

Only numbers can be entered for the code.

5 Click [OK] to add the new item to the list in the

user thread chart @

M

An asterisk (*) appears in front of the index number
for items created or edited by the user.
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M Deleting items

1 From the list for the user thread chart @
select the item to be deleted.
2 Click [Remove] @ to delete the item from the

user thread chart.

M Editing an item

An item registered in the list for a user thread chart
can be edited to change the color or thread number.

1 From the list for the user thread chart @
select the item to be edited, and then click
[Edit Item] (®.

2  Edit the item details in the same way as

adding a new item.

Edit Thread

Thread Infarmatior

aK
Calar: Mis...
oer e | Cancel
Code; 085
Brand: EMBROIDERY
Descriptior:  |PINK|

M

As with newly added items, an asterisk (*) appears
in front of the index number of edited items.

H Changing the order of items

1 From the list for the user thread chart (®),
select the item to be moved.
2 Click [Up] or [Down] e to change the order

of the item.

M

User thread chart files

Existing user thread charts can be imported, or
edited user thread charts can be used on a
different computer.

* A newly created user thread chart is saved, in
the .btc2 format with the same name as the
thread chart, at:

(Drive where PE-DESIGN PLUS2 was
installed)\Program Files (x86)\Brother\
PE-DESIGN PLUS2\MyChart




Changing Various Settings

M Specifying the number of
* The file "chart1.btc" in the [Color] folder cannot jumps in embroidery

be imported. .

» A user thread chart file in the .csv format can be deSIQn Of the DST format
imported.
The .csv file should contain information for With the DST format, you can specify whether or not
Code, Brand, Description, R, G and B, the jump stitches are trimmed according to the
separated by commas with one color on each number of jump codes. The number of codes differs
line. The RGB values must be within 0-255. depending on the embroidery machine being used.
Example: For a .csv file Click [DST Settings] in the command list, specify

the number of jumps, and then click [OK].
100,MyBrand,Black,10,10,10
101,MyBrand,White, 245,245,245

To specify a setting for importing, enter a value
beside [DST Import Setting].

Oytioes:

ST pon S,
Rurbwriprgeiorim: [ 2]
W wCET)
ke

a

Thread colors in embroidery patterns created with
this application may appear differently on the
embroidery machine, depending on the model
used.

1. Embroidery machines without a function for
displaying thread colors

The specified thread color information cannot
be displayed at all.

2. Embroidery machines with a function for
displaying thread colors

Of the thread color information specified in the
embroidery pattern, only the thread color
names are displayed on the machine.
However, the names that are displayed are
limited to the machine's preset thread color
names. Therefore, the machine displays the
names of its preset thread colors that are
closest to the colors specified in the embroidery
pattern.

3. Embroidery machines with a thread color
index

Some machines can display the thread
information specified with this application.
However, for thread colors that have been
edited or added by the user (thread colors with
an asterisk (*) at the left side), only the thread
number is displayed.
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Im||n.u

DST Import Setting

If the number of consecutive jumps in the DST
file is less than the number of jumps specified
here, those consecutive jumps will be
replaced with a stitch.

If the number of consecutive jumps in the DST
file is greater than or equal to the number of
jumps specified here, those jumps will be
replaced with a jump stitch where the thread is
trimmed.
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Changing the system unit

1  Click [System Unit], and then select the

desired measurement units ([mm] or [inch]).

==

Adjusting the screen
calibration

Measurements can be adjusted so that objects will
be displayed at the same size as the actual
embroidery at a zoom ratio of 100%. Once this
adjustment is made, it will not need to be done again
later.

Click [Screen Calibration]. Hold a ruler against the
screen to measure the length of o Next, enter the
value at e and then click [OK].

== ==

o0

Be sure to enter the length in millimeters. A value in
inches is invalid.
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Customizing User
Interface Settings

The color scheme of the applications can be
selected.

Click [User Interface Settings] in the command list,
select the desired color scheme from [Application
Color], and then click [OK].

With the [Show Status Bar] check box, select
whether to display or hide the status bar. To display
the status bar, select the check box.

If the [Reset Pane Position] button is clicked, the
docked panes ([Import])/[Color]/[Sewing
Attributes]/[Text Attributes] panes, [Sewing
Order] pane and [Stitch Simulator] pane) return to
their default displays after the application is
restarted.



For Basic Operations

For Basic Operations

Enlarging/Reducing Stitch
Patterns

Imported stitch patterns can be enlarged or reduced
in PE-DESIGN PLUS?2 in the following three ways.

1 Stitch patterns can be simply enlarged/reduced.

2 Stitch patterns can be enlarged/reduced while
the <Ctrl> key is held down.

With method 1, the stitching will become more
dense or light without the number of stitches sewn
changing. In other words, greatly enlarging or
reducing the pattern changes the quality of the
embroidery since the thread density is adjusted.
Use this method when only slightly enlarging/
reducing the stitch pattern.

With method 2, the size of the pattern is changed
while maintaining the thread density and needle
drop point pattern. However, if the original thread
density and needle drop point pattern in the stitch
pattern are not uniform, the thread density and
needle drop point pattern may not be maintained,
even by using this method. Enlarge/reduce the
pattern while checking the preview. Do not use this
method when only slightly enlarging/reducing the
stitch pattern.

a

This software allows you to create a wide variety of
embroidery patterns and supports wider ranges for
the setting of the sewing attributes (thread density,
sewing pitch, etc.). However, the final result also
depends on your particular embroidery machine
model. We recommend that you make a trial
sewing sample with your sewing data before
sewing on the final material. Remember to sew
your trial sample on the same type of fabric as your
final material and to use the same needle and the
same machine embroidery thread.
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Sewing Direction

In order to limit pulling or puckering, select a stitch
direction perpendicular to the larger edge of the
area.

Pulling or puckering more likely to occur

Pulling or puckering less likely to occur

Sewing Order

After creating an embroidery pattern made of
several different parts, be sure to check the sewing
order and correct it if necessary.

The default sewing order is the order in which the
elements are drawn.

Be careful when changing the sewing order since
overlapping areas may be incorrectly positioned.



For Basic Operations

Sewing Wide Areas

* For best sewing results, set [Under sewing] to
[On] when sewing wide regions.

»» For more details, refer to "Under sewing”
on page 107.

+ Changing the [Sewing Direction] setting
prevents pulling-in or puckering of the stitching.

* When embroidering, use stabilizer material
specifically for embroidering. Always use
stabilizer material when embroidering lightweight
or stretch fabrics, otherwise the needle may bend
or break, the stitching may pull and pucker, or the
pattern may become misaligned.

*  When satin stitching is sewn in a wide area, the
stitched area may shrink after sewing, depending
on the material and the type of thread used. If this
happens, switch to this alternate method: Select
the fill stitch and use stabilizer material on the
reverse side of the fabric.

Pattern After sewing
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Reference

Sewing Attributes

The sewing attributes for each sew type are first set to their default settings; however, by changing the settings
of the sewing attributes, you can create custom stitching.

»» For more details, refer to "Line sewing attributes” on page 106 and "Region sewing attributes” on
page 107.

Line sew types

Zigzag Stitch (»» p. 106) Running Stitch (»» p. 106) Motif Stitch (»» p. 106)

M Line sewing attributes
The available attributes differ depending on the selected sew type.

»»  "Specifying sewing attributes"” on page 63

Zigzag Stitch

Off On
Under sewing LT e e ey
AN
Narrow Wide
Zigzag width — [WWW\/W\/
Coarse Fine
Density
P Y AN
Running Stitch
Short Long
Run pitch Specify the length of one stitch.
1 time 5 times
Run time(s) Specify the number of times the outline is sewn.
w1 %5
Motif Stitch
E_’s- Select a pattern for the motif stitch. Click E-q' to display the [Browse] dialog box. Select a folder, and

then select the desired pattern (.pmf file) from the list of patterns that appears.

Specify the pattern size. The pattern can be Smaller Larger
| |__l1 20 enlarged or reduced while maintaining the width-to-
= fluiud . .
height proportion. N R e S N

106




Sewing Attributes

Region sew types

Satin Stitch (»» p. 107) Fill Stitch (»» p. 107) Programmable Fill Stitch
(Prog. Fill Stitch)
(»» p.107)

Motif Stitch (>» p. 108) Stippling Stitch (»»> p. 108)

R/ R E

H Region sewing attributes
The available attributes differ depending on the selected sew type.

»»  "Specifying sewing attributes” on page 63

Satin Stitch/Fill Stitch/Programmabile Fill Stitch

Sets underlay stitching on or off. To specify underlay stitching, select the check box.
Off On: With text patterns

Under sewing
On: With other patterns (Shapes)

Coarse Fine

Density

This cannot be specified for text patterns. Manual

Manual: Sews at a fixed angle.

Direction Drag or select a value to specify the angle.
Auto: Automatically varies the sewing direction
according to the shape of the region.

No compensation Longest
compensation

Pull Lengthen the sewing region in the sewing direction
compensation to adjust for pattern shrinkage during sewing. % %
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Sewing Attributes

Programmable Fill Stitch

Click the pattern display box to display the Browse dialog box. Select the desired pattern

Programmable fill from the list of patterns that appears.

Notes on programmabile fill stitches

In some case of the sew type and pattern directions setting of a programmable fill stitch or a stamp, lines will
not be sewn.

Use the Realistic View to view exactly how the stitch pattern will be sewn. To get an even better view, make
test samples of different settings.

Examples of programmabile fill stitching:

Example 1 Example 2 Example 3
E Stitch direction: 45° (default) Stitch direction: 90° Stitch direction: 0°

- 3 }‘1 E—-' 3 i I-w--n”lm-m""-ﬂm" --'-»nh; . % i f 3 ? il i— i 1
— el I IS Y] E i L= é . i _=
T FRIAIALIA
Blan Mo b e W r:_i 5,! I! [4!
g8y s iy b "Sp AF S F 3
[ — o F:1f:11;
M W Wi Au.«-nh ] 1 "4 ; 5‘
g P g P e 7. 97.9F.
B b e e = 1 = } : } i ;_
Motif Stitch
Pattern and size of the A ke bt s . ) "
motif stitch patterns »»  "Motif Stitch" in the "Line sewing attributes" on page 106
Stippling Stitch
Short Long
Run pitch Specify the length of one stitch.
P This cannot be specified if the motif stitch is used. The turns are The turns are more
smoother. angled.
Narrow Wide
: 9] ¢
Spaci W
The pattern is finer. The pattern is coarser.
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Motif Stitch Pattern

Sewing Attributes

Motif Pattern L Pattern
Name Name
mot001 S5 moto14 | F% A%
s i el
mot002 mot015 RO
mot003 mot016
mot004 mot017
mot005 mot018 DD
mot006 mot019 B
==
mot007 mot020
A
mot008 mot021 | g™ |
mot009 ,/(,\5{\///(;:;(;/ mot022 ,:‘,5%; ‘:" “\:
moto10 | /3o ae, moto23 | &
mot011 mot024 | S/ ,7,, d
f f4 .C/ l
mot012 mot025 R S
mot013
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Prog. Fill Stitch Pattern

Fill
Pattern
Name

Pattern

Fill
Pattern
Name

Pattern

patod1 | Lo hi A E pato12 | 0
%;\%%%S SEMN gwt\‘-a{u
pat002 pat013
pato03 | i || pat014
A AN AN
pat004 | Lo pat015
\\\\‘\}\‘\_\:\;\\\\ hum-mw;&m
atoos | RN at016 it :1 i
paicos | (RRRRER | | e | ERERIMGRAG
at006 ato17 | [
P P “?Q‘Htg\)\ k
pat007 pat018
pat008 pat01e | NI
Ittty
| R
-& {
pat010 pat021 ‘H‘u{j.."nﬁ?\m‘f‘}
AN
pat011 pat022

N




Font List

Font List

Text
Font Name Text Outlines

01| S0t | ABCDE abede | (0500
002| St | YBEOE scts | (050
' 10 mm
003 | Gothic 01 ARCAE abede (0.39")
. 10 mm
004 |  Serif 02 ABCDE  abede (0.39")
005|  Script 02 ABCDE abede 28?’:;?;
. 8 mm
006 Serif 03 ABCDE abede | (0.31")
007 | Block 01 ABCDE abcde (%.?g?)
10 mm
008| Block02 | ABCDE abcde | (0.39"
' 10 mm
009 | Gothic 02 ABCBTE abcde | (0397
10 mm
010| Block 03 ABCOE abede | (0.39")
011 | Decorative 01 | ABCOE abcde 2(()) 3T;T;
10 mm
012|  Block 04 ABDE abcde | (0.39")
9 mm
013|  Block 05 ABCDE abcde (0.35")
014 Script 03 ARBCHDE abece 2(? 3rrs1;;r;
015 | Decorative 02 ASBYE absida ?g;;;;
016 | Decorative 03 ABCDE abede 28 ;Em)
. 10 mm
017 |  Script 04 ABCDE abede | (0.307)
018 Gothic 03 aBADBE 2(()):2;)";
019|  Script 05 £ BEDE zgegn;
9 mm
020 |  Block 06 ABCDE abede | (035"
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No.| Font Name

Text Outlines

Min.

size
. 10 mm
021 Gothic 04 ABECHE (0.39")
. 10 mm
022 | Decorative 04 £BEDE  ahede (0.39")
023| Decorative 05 | 0 2 €. B.&. (% 3
. 10 mm
024 Gothic 05 ARLDG (0.39")
. 10 mm
025 | Decorative 06 ABCDE (0.39")
026| Gothic 06 ABEDHE 2(? g;m)
027|  Block 07 ABCDE 2(? g;";
. 10 mm
028 Gothic 07 ABIDE (0.39")
029 Brussels Demi — 10 mm
outine | AJBCIDE albede | (0.39m
Calgary 10 mm
030 | Mediumitalic | ABCDE abede | (0.397)
10 mm
031 Istanbul ABCDE abcde (0.39")
10 mm
032 LosAngeles | KBCDE abcde (0.39")
033 Sai 10 mm
aipan ABGDE abecde | (.39
. 10 mm
034| SanDiego | ABCDE abede | (0397
Sicilia Light 10 mm
035 ltalic ABCDE abcde | (0.39)




Font List

Small Text

No. | Font Name | Text Outlines | Size
5-6 mm

01 Utah Bold S ABCDE abede (0.20-
0.24")
5-6 mm

02 Belgium S (0.20-
ABCDE abcde 0.54")
Calgary 5-6 mm

03 | Mediumltalic s | ABCDE abede 80'2249;
3-4 mm

04 Utah SR ARCDE abcds (0.12-
0.16")
Calgary 3-4 mm
05 | Mediumltalic ABCDE abede (0.12-
SR 0.16")
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Troubleshooting

Troubleshooting

If a problem occurs, click ﬂ *, then [Customer Support] in the menu to visit the following Web site, where
you can find causes and solutions to various problems and answers to frequently asked questions.

If you have a problem, check the following solutions. If the solutions suggested do not correct the problem,
contact your authorized dealer or Brother Customer Service.

Problem

Windows® does not start when
you turn on the computer with
the "PE-DESIGN Software
Key" plugged into the USB port
of the computer.

The software is not installed
correctly.

The message "No PE-DESIGN
Software Key is connected.
Please connect a PE-DESIGN
Software Key." appeared.

Estimated Cause Solution Page
The "PE-DESIGN Software | Turn on your computer without the "PE-
Key" is plugged in when DESIGN Software Key" plugged into a
Windows® is started. USB port.
An operation not described
in the installation procedure
was performed. (e.g., . . Refer to
. Follow the on-screen instructions to " .
[Cancel] was clicked or the correctly install the software Installation
"PE-DESIGN Software Y ’ Guide".
Key" was removed too
early.)
Check that the "PE-DESIGN Software
The "PE-DESIGN Software Key" appears in the computerg, list of
Kev" is not connected removable storage devices. If it does
Y ’ not appear, unplug the "PE-DESIGN
Software Key", and then plug it in again.
. . Refer to
I;Eg;gr&ilggf?wn;:ae Leave it plugged in, and uninstall, then | "Uninstalling the
v re-install PE-DESIGN PLUS2. Software" on
Key" is corrupted.
page 115.
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Problem

Troubleshooting

Possible Cause

The error message
"Unexpected file format"
appears.

or

Your embroidery pattern or
image cannot be opened.

When opening an embroidery
pattern
(Application button > [Open])

.pes

The data may be corrupted.

.phc (machine embroidery
format)

The file cannot be opened,
but it can be imported.

— ([Home] tab > [Import
Patterns] > [from File])
Otherwise, convert the file to
the PES format, and then
open it.

Other manufacturers'
compatible formats

(.dst, .hus, .exp, .pcs, .vip,
.sew, .jef, .csd,

xxx, and .shv)

The file cannot be opened,
but it can be imported.

— ([Home] tab > [Import
Patterns] > [from File])
Otherwise, convert the file to
the PES format, and then
open it.

Incompatible formats

The file cannot be used.

When importing embroidery
patterns

([Home] tab > [Import
Patterns] > [from File])

.pes, .phc,

Other manufacturers'
compatible formats

(.dst, .hus, .exp, .pcs, .vip,
.sew, .jef, .csd,

XxX, and .shv)

The data may be corrupted.

Incompatible formats

Convert the file to a
compatible format, such as
PES, and then use it.

When opening a background
image

([Image] tab > [Open])

or When opening an image

for Stitch Wizard

(Auto Punch, Photo Stitch 1

and 2, and Cross Stitch)

.bmp, tif, .jpg, .png, and .gif

The data may be corrupted.

Images in formats other than
those listed above

The file cannot be opened.

— Use an image in one of
the formats listed above.

When importing an image as
an embroidery pattern
([Home] tab > [Import
Patterns] > [from Vector
Image])

.wmf, .emf, and .svg

The data may be corrupted.

Vector images in a format
other than .wmf, .emf, or
.svg

Convert the file to the .wmf,
.emf, or .svg format, and
then import it.

Raster images (.bmp, .jpg,
etc.)

Currently, these files cannot
be imported. Open them in
the background and use
them for tracing.
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Support/Service

Support/Service

Checking for the Latest
Version of the Program

Click ﬂ * in PE-DESIGN PLUS2, then [Check for
Updates].

The software is checked to determine whether or
not it is the latest version.

If the message shown below appears, the latest
version of the software is being used.

Check for Most Recent Version

i/ The most recent update for PE-DESIGM is already installed.

[ Alwaps check for most recent version at startup

If the message shown below appears, the latest
version of the software is not being used. Click
[Yes], and then download the latest version of the
software from the Web site.

Check for Most Recent Version

The most recent version of this program is
3 available or the Wb,

i
' Do you want ta download it and update your
program?

[ Always check for most recent version at startup

Ho Check Details...

a

» This feature cannot be used if the computer is
not connected to the Internet.

* It may not be possible to check for the latest
version if a firewall is turned on. Turn off the
firewall, and then try performing the operation
again.

« Administrator privileges are required.

M

If the [Always check for most recent version at
startup] check box is selected, the software is
checked at startup to determine whether or notitis
the latest version.

Technical Support

Contact Technical Support if you have a problem.
Please check the company web site
(http://www.brother.com/) to find the technical
Support in your area. To view the FAQ and
information for software updates, visit the Brother
Solutions Center at (http://support.brother.com/).

a

Before contacting web site:

(1) Please have your Windows® Operating
System updated to the most current
version.

The make and model number of the
computer that you are using as well as
the Windows® Operating System
version.

)

(3) Information about any error messages
that appear.
This information will help expedite your

questions more quickly.

Please check and update the software
to the latest version.

(4)

Online Registration

If you wish to be contacted about upgrades and
provided with important information such as future
product developments and improvements, you can
register your product online by following a simple
registration procedure.

Click [Online Registration] on the i ~ menu of PE-
DESIGN PLUS2 to start up the installed Web
browser and open the online registration page on
our Web site.

http://www.brother.com/registration/

M

Online registration may not be available in some
areas.
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Support/Service

Uninstalling the Software

1 Click ﬂ and then [All apps].

Search the web and Windows

Click [PE-DESIGN PLUS2] from the
application list, right-click [PE-DESIGN
PLUSZ2], and then click [Uninstall] in the
menu.

e

3

In the [Programs and Features] window,
select [PE-DESIGN PLUS2] and click
[Uninstall].

63 Programa and Fasturm - o

* [ « Programs + Programs and Fastures

Contral Panal Homa -
Uninstall or changs a program

Te uriratal

o[ e =
Ham . L

W Tum Windowstesturs on or
o

Publisher
Wicresoft Comenstion

TMcres oft Visua) C++ 2008 Redistrinutsie - 4 503,

I . PE-DESIGN PLUS2 Brather nduzties, Lid. I

Brothor Ndustrias, Lt Proskact versior: 100000

~ Halp ik ity s, rctharzam,

M

If a confirmation message appears, click [Yes] to
continue with the uninstallation.
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Click [Yes].

) User Account Cantral »

nt to allow this app to update saftware an

izl Program name:  PE-DESIGN PLUSZ
t Venfied publisher. Brother Industries, Ltd.

File arigin: Hard drive on this compuber

Change when these notifications appear

) Show details

— The software will be uninstalled.

M

- For Windows® 8.1, click the down arrow in the
[Start] screen to show the [Apps] view, and
then right-click [PE-DESIGN PLUS2] under
[PE-DESIGN PLUS2]. Click [Uninstall] in the
taskbar. Select [PE-DESIGN PLUS2] and click
[Uninstall] in the [Programs and Features]
window, and then click [Remove].

« For Windows Vista® and Windows® 7, click the
[Start] button, then [Control Panel]. Select
[Programs and Features] in the [Control
Panel] window. Select this software, and then
click [Uninstall].




Access key
Advanced stitch wizard
Application appearance
Application button
Appliqué
Applique Wizard
Attributes
Line sewing attributes
Region sewing attributes ...
Sewing attributes
Text attributes
Auto Hide
Auto Punch Wizard
Auto Punch Parameters ....
Auto Scroll

Back SHCh .....oooviiiiiie 78
Background image Density ..........ccccoiiiiiiiiiiiiees 16
C
CenteriNg ...coocviiiie it 53
Change ColOr .......cceeiiiiiieiiiiiie e 82, 86
Changing
Thread color order ..........ccccovvvieiiieiieiee e 101
Character Spacing ........ccccccocevrvieiiiiniie e 69
Checking
SEWING OFAEI ..ottt 37
Stitching
Closed paths ...
Color
Color button ........cccueeiiiiiirec e 61
Color changes ..........cccooviiiiiiiiiiee e 39
Color Option ...cevveeiiieciee e 81, 86
Color PaANE ..o 10
Combining
Pattern colors ... 37
Copy
Mirror COopies ........ccccoiiiiiiiiiiie e 28
Create Offset Lines .......ccceveviiiiiiiiiiiiiccieeee e 58
Creating
New thread color chart ..., 100

Cross Stitch Wizard

CSV e
D
Delete IMage .......oooevveieiiiiiiceceee e 92
Delete Point
Deleting
Thread color charts ........c.cccoeiviiiiiiniinie e, 100
Thread colors from charts ..o 101
Design Page Size .........ccocooviiiiiiiiiniiscceceee 15, 32
Multi-position hoOpS .......ccvvveviviiiiiieieeeiiieeeen 93
Design Property .........ccccooieiieioiniiniese e 11, 39
Design Settings .......covcvevieeiiiniiieeeeee e 32,93, 95
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Displaying
Color pane ....

Images .........
Import pane ..
DOCKING +eiiitiiieieie et
DUuplicate ......oooiiiiiii e
E
Edge radius ........cooouiiiiiiiiie e 49
Edit POINt ..o 52
Editing
Grouped ObJECES .....cccveiiiiiiiieiee e
Sewing order ..........
Thread color charts ...
Thread colors .........
Embroidering area ................
Embroidery attributes for text .............ccccoeis 70, 71
Embroidery patterns
Adding comments ........coccciiiiiini e 39
CenteriNg ..cccuveeieiiiieiie et 53
From images ... .73, 87
GrOUPING .eevvieieeeiieiee ettt 55
Multi-position hoops .. .94
Printing ..oooeei 97
EMF .o 40, 42
EXport FCM File ....cccooiiiiiiiiiee e 59
FOM e s
FIID e e
Flip Horizontally
Flip Vertically ...
FI0AtING .oooeeiee e
FOnt List ...
Font selector ...
Grid .o
Grid Interval ..
Show Grid ....
SNap t0 Grid ....cceviiieiiiiie e
With AXES ...oiiiiiiiii e
Group
(€14 TU] o SRR 55
UNGIOUP ..ot 55
GUIENINE ... 33
H
H-AITANGE ....oiiiiiiieic e 106
HEIP BULLON ..o 10
Hide List ...ccoooveviriciiene, .67
Hide Objects Not Stitched . .41
Hide oo, .12
Hint View ..... .63
Hole sewing .... ...56
Appliqué
CaNCEI .
Hoop changes ...
H-SPaCING ...oeieiiieiieie e



Image to Stitch Wizard ..........cccocoiiiiniiiiiceee 87
IMage TUNE .....ooiiiiie e 88
Images
Converting to embroidery patterns ................ 73,87
MOVING oo 91

Outputting .92
Resizing .. 91
Saving ..... .92
Scaling . .91
IMPOIt PANE ... 13
Import Patterns ........oocciiivieiiiieeeee e 13, 44
Importing
Clipboard images ........cccceruieeeiiieeeiiie e 91
Embroidery patterns .... 13, 44
From Vector Image .......cccccoeiiiiiiiiiniiee e 40
Images .....cccoeveveerene .90
IMPOrt PANE .....cooiiiiiiiie e 13
Input
From Clipboard .........ccccoiiiiiiiiiiieeeeecieee 91
From file ....ooooveeeieeeee e 90
L
Line
LiN€ COIOT ...oviiiiiiieiee e 61,70
Line color button ..........ccceiiiiii e 62
Line Sew Type ..... .62
Line SEWING ..coeiieeiiiiicieee e 62
Line sewing attributes .... ..106
Line Interval ..o 86
M
Max. DENSILY ..coocuieiiiiiiie e 86
Max. Number of Colors 75,77
MEASUIE ... e 34
Measurement units .... ..103

MEIGE .. 57
Mirror Copy ... .28
Modify IMage .......ooevvciiiiii 91
Modify Overlap ........cccceeieiiiiiiie e 56, 57
Motif stitch
Move to Center ........coouveiiiiiiiiee e 53
Moving
Embroidery patterns to center ............ccccocieiieie 53
Images ......cccoveeiiieiiiiceeeee

Multi-position hoops

NEW oo 43
NOT DEFINED ....ooiiiiiiiiieeciee et 62
Not sewn
LiNe o 62
REGION ..o 63
o
OffSEt lINE ..o 58
Online Registration ...........ccovvioeiiiiiiienceee e 114
Open
PESFIle i
New Design Page .............

PE-DESIGN PLUS2 file
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Open Image
from Clipboard ..........ccccoiiiiiiiii e 91
from File

Open paths ........

OPHMIZING .ot
HOOpP Changes .......coocieiiiiiieiie e 95
Sewing Order ... .28

OPLIONS et 98
Customize ....... 98, 99
Design Property .......ccccoiiiiiiiiie e 96
DST Settings .......c........ ..102
Edit User Thread Chart ..........cccooiiiiiniiiiiiieee 99
Option bULtON ....ccccveeieiee e 10
Screen Calibration .. ..103
System Unit .................. ..103

User Interface Settings .
Other ZoomTools .
Outline

Closed Curve

Closed Straight Line

Open Curve

Open Straight Line .

Text
Output

To Clipboard

To File

Pan e
Pattern
Pattern information ...........cccoiiiiiiiin 39
Adding comments .........ccceciiiiiiiicn 39
Multi-position hoops .. .96
PE-DESIGN Software Key ........ccccooviiiiiiiiiiiiiiciee 7
Photo Stitch 1 Wizard .. .79
Candidates ...... .82
Color ..o .79
Parameters ... 81
Photo Stitch 2 Wizard ..........occooeiiiiiiieeee 84
Color ......ccceeueeee
Parameters ...
PreViEWing ..oooooiiiiieiee e
Print
Embroidery patterns ..........cccoccceeieiiiiiinee e 48
Multi-position hoops .. .97
Preview ..... .48
SettingS e 47
Programmable fill stitch .. ..108
Pull Compensation ..........cccocieiiiiiiiiiie e 107
Q
Quick Access Toolbar .......ccccceeeeeeeiiiiiiieeeen, 10, 11, 98
R
RealistiCc VIEW ......cccoviiiiiiiee e 35
Realistic View Settings ........ccccoooiiniiiniiiiiiiiecceee 35
Rectangle
REAO .
Region
Region COIOr .......ccuvviiiiiiiii e 61,70
Region Sew Type ......ccovviiiiiiiiiiiesece e 62
Region sewing ..... .62
Region sewing attributes .. ..107
Registration ..........ccccoeiiiiiiiiii 114



Remove OVerlaps ........cccccoveriieiiieiie e 57
Resizing
IMAGES ...eiiiiiie e 91
RIDDON .. 10
Rotate .......ccccoviiiiiiiiennnnns 54, 55
Rotate Right / Rotate Left ..o 92
RUN PICH e 82
Running stitch ... 106
S
Satin SttCh ..eeoiie e 107
Save / Save As
Embroidery patterns ...........ccoceeiiiiiiiniii 46
Images
Save Image .
Scaling patterns ........cccceiiiiii i 54
Select from Candidates ..........ccccooieeiiiiiiiniiieeceee 82
SeleCt TOOIS ...ooieiiiiiiii et 53
Selecting
All embroidery patterns ...........ccccoecoeriiieennieeene 53
(0701 o] £ TSRS
Patterns
Send
Send to USB Media .......coooiieiiiiiieeiieeecieeeeee 18
Send to Your Machine .... .18
Sew Page Color .......ccooiiiriiie e 82
Sew type selector ...... 62, 63
Sewing attributes ... 106
SettiNg .ovieiie e 63
Sewing Attribute pane .... .10
Sewing direCtioN .......cccoovueieiiiie e 107
Sewing Option ..... 82, 86
SeWing Order ..o 37
EditiNg .oveeeeeeeee e 38
Hide Objects No Stitched ..
Select Patterns ..................
SeW First ..o
SeW Last .ooeviiiiie e
Sew Next ...........
Sew Previous .
Sewing Order pane .........ccccceeeieeeiiiie e 10
Show by color order ..........ccccoiniiinicniienieeenn 37
Thread color
Zoom ..............
Shape patterns .......cccccoeccvveieee e
Shapes TOOIS ......coruiiiiiiiie e
Shortcut keys .
Show by €OIOr Order ........cooviiiiiiiiieiee e 37
ShOW Grid ..o
Show List ...
SHZE it e
SMall TEXE .o
Snap to Grid .
SOlA VIEW ..ttt
Special colors
Specifying ........
Status bar ........
Stippling stitch .
Stitch patterns ..., 8
Stitch Simulator 10, 36
SHECh VIEW .ot 35
SVG e 40, 42
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Technical Support
Text
Edit text
Enter text
Text Attribute pane ....
Text Attribute Setting .
Text Line Sew Type
Text patterns
Text Region Sew Type .
Text Size selector
Text Tools
Thread Chart
Thread colors
Adding to charts
Creating new colors ..
Deleting charts
Deleting from charts ..

Editing ....ccoooieiiee ..101
Editing charts .. ..100
Order ............ ..101
Total COIOIS oo 39
Userlist ........... 101
Thread Colors Used ........cccoecieeiiiiieiiiieee e 86
Transform ... 52, 65, 69
U
UNdEr SEWING ...cooviiiiiiiieiie et 106
LT o o TSR

Ungroup ...
Unit

USB Media .....oovviiiiiiiiiiieie e 18

User thread color list ........cccceeeviiiiiiieeeeecieee e 81
\'/

V-AITANGE i 106

Vector images ...... 40, 90

View mode buttons ........ccccceeveiiiiiiiiee e 1

V=SPaACING .uviiiieiiiiieieee e 108

Zigzag StitCh .......oooiiii
Zoom
Actual size zoom
Selected object zoom
Zoom All
Zoom In/ Zoom Qut ..
Zoom ratio




Please visit us at http://support.brother.com/ where you can get product
support and answers to frequently asked questions (FAQSs).

English
Version 0
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